Cuaderno de Bitacora: Anotacionesy Documentacion.

Apunte 1.

Fase de documentacién (1-15 de Octubre de 2002):

= Sehaestudiado proyectos similares para proporcionar punto de partiday vision
de conjunto, como son: Autopilot, Cal-Poly Flight Simulator y Marvin.

= Se haelegido como fabricante del microcontrolador a ATMEL. Se ha hecho
acopio de documentacién del mismo optandose por €l kit de desarrollo
AT91EB40A. Documentacion asociada: caracteristicas eléctricas del micro de la
placa, SW de programacién cruzada (Angel), disefio del micro y emsamblador.

= Estudio de diferentes opciones de S.O. para la placa objetivo: uClinux, eCos,
uCosl, Angel (proporcionado por ATMEL).

» Estudio de entornos de programacion sobre plataformas de Intel:
= Bago Windows: Matlab: Simulink, RTW (Real Time Workshop), Aerospace

Blockset, Fuzzy Control y compiladores.
= Bgo Windowsy Linux: WxWorks.

» Lamayor parte de ladocumentacion se encuentraen el CD1y en el ordenador
del departamento AEROL.

(& Fase de prueba de distribucion uClinux (8-12 de Octubre de 2002):

= El paguete de la distribucion de uClinux para el chip de ATMEL se encuentra
disponible en internet (véase “ Targeting uClinux on the ARM7TDMI with GNU
Tools”). Se bgj6 al portéatil de Ismael Alcala (profesor tutor) y se me
proporciond en el CD1.

» Paraprobar como funcionaba dicho paquete se necesitaba de un ordenador
configurado, pero en & departamento no se disponia de uno. Ante este problema
se opto por acudir aMiguel Angel Lupiéfiez Rueda; aportd su equipo portétil
con una distribucién de Debian.

= El paquete era de RedHat (.rpm) luego tuvimos que transformar sus relaciones
de dependencias alas de Debian (.deb). EI SW necesario se baj6 de Internet
desde la conexion de mi casaal portétil de Miguel Angel.

= Unavez transformada se descomprimio el pagquete observandose que disponia
con un fichero “script” que contenia todas las 6rdenes necesarias para compilar
el kernel de uClinux y e compilador de codigo libre para el micro de ATMEL.

» Enun equipo PII1-500 se necesit6 cerca de 40' en la compilacion.

= Hacefataconfigurar e kernel.

(b) Fase de configuracién del sistema (15-21 de Octubre de 2002):

» Parad estudioy andlisis posterior del kit de desarrollo se necesita usar un PC.
Para ello se utiliza el P133 del departamento.

= Paraprobar los distintos SW de desarrollo se ha optado por instalar W95 y
Linux RedHat 6.7, cada uno en una unidad de HD del ordenador.

= Lainstalacion de ambos sistemas operativos se efectud con éxito tras comprobar
gué HD’ s estaban disponibles.

= Se hace necesario comprobar el correcto funcionamiento de los mismos.

Incidentes a destacar: debido a que el kit de desarrollo ve retrasada su entrega frente a
lafecha que indico el fabricante, €l proyecto se encuentra a la espera.



Apunte 2
Fase deinstalacion de SO:

31-10-2002: Yaesta instalado un nuevo CD-ROM en e P133 para poder instalar
W95y Linux RedHat 6.7, cada uno en una unidad de HD. Habra que esperar d
Lunes 4-11 por la mafiana para acercarme por el laboratorio porque él tutor no
estara por € puente del 1-Nov.

31-10-2002: Ismadl me ha comentado por e-mail que el kit de desarrollo todavia
no ha llegado, aunque e fabricante dijo que estaria hace dos semanas. El llamaré
al distribuidor para saber més informacion.



Apunte 3
Fase de aclaracién de dudas:
= (02-11-2002: Le pregunté a Miguel Angel como podriarealizar lainstalacion de
los dos SO. He aqui las notas de o que me contesté:

= Esposible que debido a que se trata de un P133, no arranque del CD-ROM
s no encuentra un SO en la disquetera. En este caso, defino en la BIOS que
leadel CD forzosamente al iniciar € sistema.

» Lainstalacion de ambos sistemas operativos posee interfaz gréfica.

= Seredizan las particiones con la distribucion RedHat 6.7:

= Unapara swapping de Linux: 256 Mb.
= Otraparael propio Linux: 2 Gb; con el nombre “/root”
= OtraparaW95s: 1,8 Gb; formateada en FAT16 o DOS.

» Sesdedelainstalacion de esta distribucion con Cirl-Alt-Supr.

=  Seprocede ainstalar W95; éste solo reconocerd a particion de DOS/FAT16,
donde seinstalard. Grabard en el sector de arranque del HD el procedimiento
por € cual arrancara como unico SO.

» Unavez instalado se pasaainstaar & Linux. Este reconoceré que existe un
W95 sobre la particion de DOS. Nos saltamos el proceso de las particiones
del HD, procediendo alainstalacion del SO. Este actualizara el sector de
arranque del HD para posibilitar €l doble arranque mediante LILO.

Fase deinstalacion:

= (03-11-2002: Mahana procederé ainstalar los sistemas en el P133. Hablaré con
Ismael para que me proporcione ambos SO’s.

= (04-11-2002: No lo encuentro en su despacho. Le envio desde mi casa un correo
preguntandole cuando lo puedo encontrar.

= (05-11-2002: é me contesta diciéndome que los CD’s de instalacion se
encuentran a lado del PC, en unos cagjones. Efectivamente.



Ap

a)
b)

c)

unte 4:

Fase de I nstalacion (05-11-2002):

=  SW disponible:

CD de instalacion de WO5.

Disguete de arranque W98.

Distribucion Linux RedHat 7.2.

=  Objetivo: lograr un arranque dual Linux — W95 en P133 de ISA.
= Planteamiento:

Redlizar las particiones con € instalador de Linux.

Instalar W95 en particion DOS.

Retomar la instalacion de Linux sin modificar las particiones de DOS.
Colocar sistemade arranque LILO en sector de arranque del disco duro primario
paralograr €l arranque dual.

= Principales Problemas e Incidencias:

La secuencia de arranque no empieza con e CD-ROM.

Existe proteccion desde BIOS contra escritura en el sector de arranque del HD
primario para evitar la entrada de virus.

No haber instalado nunca un sistema dual, ni una distribucion Linux.

= Soluciones planteadas:

Programar en la BIOS la prioridad en e arranque: CD-ROM, a,, c..
Inhabilitar la proteccion contra escritura en la BIOS.

Lainterfaz gréfica que ofrece la distribucion Linux es intuitiva

= Desarrollo del Proceso. Anotaciones:



Apunte5:

1) 5/11/2002: Colocamos el CD1 de Linux en el CD-ROM. Forzamos la secuencia de
arranque de la Bios: BootUpSequence CDROM ,a;,c.. El CD1 es autoinstalable.

2) Instalacion de Linux en entorno gréfico: definimos las particiones de la siguiente
forma:

Particion Tamano Nombre S'Ste”.‘a de | Punto Qe Formateo
(Mb) Archivos Montaje

/dev/hdal 1914 Sistema Vfat - Si

/dev/hdbl 3095 Usuario Viat - Si

/dev/hdcl 3702 Linux Ext3 [/root Si

/dev/hdc2 400 Swap Swap - Si

Se usan los dos primeros HD’s para Windows y € ultimo, dividido en dos particiones,
para Linux. Se aceptan las particiones asi definidasy salimos del proceso de instalacion
de Linux: Ctrl-Alt-Supr; Linux gecuta un proceso de cerrado ordenado y expulsa de
CD. Iniciamos rearranque.
3) Colocamos e CD de W95y € disquete de W98 (sin & no se detecta el CD de W95
puesto que no es autoinstable). W98 no detecta como unidades vdlidas los HD' s ¢\
y d:\; formateamos ambos. También detecta como CD-ROM af:\; gjecutamos
f\instalar.exe. El proceso de instalacion se bloque porque saltala alarma: “Boot
Record”; blogquedndose €l sistema.
Debido a que W98 no reconocio sus particiones como validas, retomaremos el
proceso de definicidn de particiones bajo Linux.

4) Definimos las particiones siguiendo el mismo esquema que & en punto (2).
5) Iniciamos el sistema bajo W98-DOS:

Se reconocen:
CA\ Sistema
D\ Usuario
E:\ MS-Ramdrive
F\ CD-ROM
Se ha solventado €l problema por la falta de reconocimiento por W98 de sus propias
particiones.

No se reconocen las particiones de Linux.
Ejecutamos f:\instalar.exe, pero surge e mismo problema: Boot Record: bloqueo del
sistema.
6) Iniciamos el sistemacon el CD1 de Linux parainstalar completamente € sistema
operativo:
= Mantenemos e mismo esquema de particiones, pero sin formatear las que estan
dedicadas a W98.
= Grabamos €l gestor de arranque del sistema LILO para que se dé € arranque
dual, definiendo como S.O. por defecto a DOS. Aqui no existen problemas de
“Boot Record” aungue se escriba en el sector de arranque del disco.
»  Seefectlialainstalacion completa del sistema junto con X-Window.
*= Renicio.



7)

8)

9

Dua Boot: Dos — Linux:
= Si DOS:
= Con disguete W98 y W95-CD: f:\instalar.exe - problema “Boot Record”,
bloqueo del sistemay no se puede instalar.
= Sin disquete W98 no se detecta S.O. vdlido.
= S Linux: seiniciae sistema satisfactoriamente; debido a que no me manejo por
é no sé como instalar W95.
Iniciamos el sistema, pero entramos forzosamente en la configuracion de la BIOS.
Para inhabilitar la proteccién contra escrituras en € sector de arranque de la
particion primaria seguimos |0s siguientes pasos:
= Standard Bios Setup: ok
= Boot Sector Virus Detection: Disabled: ok
=  Save Settings and Exit: ok
Iniciamos el sistema con el CD1 de Linux: definimos las particiones manteniendo €l
esguemadel punto (2). Ctrl-Alt-Supr.

10) Iniciamos €l sistema eligiendo DOS: W98-DOS reconoce las particiones del punto

(5). Con el CD de W95 gjecutamos f:\instal ar.exe realizandose toda la instalacion de

W95 sobre c:\windows habiéndose solventado € problema “Boot Record”.

11) Arranque de W95 por 12 vez:

= Existen problemas porque &l sistema no encuentra el “s3mm.dll”; buscamos este
archivo en e CD de W95 de forma manual desde W98-DOS, pero no existe
explicitamente puesto que son todos los archivos tipo Cabinet (formato
comprimido de Windows).

= Tampoco reconoce € sistema la unidad de CD-ROM aunque haya sido instalado
desde uno.

= Tampoco reconoce la existencia de red, aunque esté una tarjeta Ethernet
correctamente configurada y reconocida: posible falta de definicion de DNS
(dominio del nombre del servidor).

12) Iniciamos el sistema: ahora no pide ningun archivo, pero no reconoce € CD-ROM

ni lared. Mensaje “Bienvenido a Windows'.

13) 7/11/2002: Decido descartar el W95 e instalar W98SE:

= Uso ladistribucién de W98SE que tengo en mi casa.
=  ConW98-DOS formateamos c.\ y instalamos W98SE desde CD-ROM.

14) Inicio por 12 vez:

= Definicion de usuario:
= Nombre: Sergio Latorre.
=  Organizacion: Proyecto AERO1 FCS.
» |niciando la base de datos de drivers. HW y Plug'n’ Play...OK
= Reinicio de W98SE. Finalizando la configuracion...OK
* Renicio de W98SE.
» Busgueda de nuevo HW: SMC EtherEZ (8416).
= Detecta: Puerto de comunicaciones, puerto de impresora, PCl VGA, S3
Tri64V y PCI (765).
* Renicio de W98SE.
= Faltaarchivo msmp32.dil: no facilita conexiones de red.
= Detectando HW nuevo: no hay HW nuevo.
= Mensgje de “Bienvenido a Windows 98"
= Forzamos la busgueda de nuevo HW desde €l Panel de Control.
=  Sedetectan problemas con:
SMC EtherEZ (8416).



= PCI Multimedia Audio Device.

=  Compatibilidad para Administracién avanzada de Energia.
=  Windows dice que estan correctamente instalados, pero tienen problemas de

funcionamiento.
= Reinicio de W98SE: solicita ciertos archivos que aparecen en |os registros del
sistema, pero que no existen en e sistema de ficheros. Estos son:
= Vnetsup.vxd; vnetbios.vxd; vredir.vxd; dfs.vxd.
=  Observando en qué fichero Cabinet de la distribucion de W98SE estan se
usd el ordenador Pl1350 para extraer los ficheros requeridos del CD de
WO9BSE mediante WinRar a un disguete.
= Observamos en qué subdirectorios aparecen estos ficheros dentro del
ordenador PI1350 y los grabamos respectivamente en el P133.
= Reinicio de W98SE en P133: ya no solicita estos ficheros. problema solventado;
pero sigue sin reconocer lared (¢msnp32.dil 0 DNS?).

15) Salimos de W98 y reiniciamos con CD1 de Linux para proceder a su total

instalacién (borrando la instalacién ya hecha del mismo).
» |nstalacion gréfica de Linux:
= Definicién de particiones (mismo esquema que en (2)); al formatear hdcl y
hdc2 se borra el sistema Linux preinstalado.
» LILO end sector de arranque: DOS — Linux; DOS por defecto.
= |nicio de instalacion: copia de archivos.
= Formateo del sistema.
» Transferenciade laimagen del programa de instalacion a hdcl.
= |nstalando paguetes.
= |nstalacion completada: OK.

16) Iniciamos € sistema eligiendo Linux: se instalé en modo gréfico: posee barra de
tareas |lamada “ Panel”.

17) 8 y 11/11/2002:Definimos DNS en P133 observando la direccion 1P del servidor
gue muestra el PI1350 mediante “ipconfig” bajo terminal de comandos (DOS). El
ordenador nos devuelve:
= adaptador Ethernet conexion érealocal:

= direccién IP: 193.147.161.70

= méscarade subred: 255.255.255.0

= puertade enlace predeterminada: 193.147.161.1

= servidor DNS primario: 193.147.161.202

= gervidor DNS alternativo: 150.214.130.15
Si gecutamos “ipconfig” en e P133 nos indica que no esta definida: ésta puede ser
una de las causas de la falta de reconocimiento de la red: no esta definido cud es €
servidor. Los valores devueltos por PI1350 son copiados a otro ordenador, savo la
direccion IP de la maquina, que setomo: 193.147.161.71. Tras esto e P133 pide que
se reinstalen los controladores (drivers) para la tarjeta de red SMC EtherEZ (8416).
Los archivos que se van solicitando estan € en CD de W98SE, pero hay que
extraerlos de los ficheros Cabinet (.cab) mediante WirRar del Pl1350; éstos son:

Nombre fichero Cabinet origen Nombre fichero Cabinet origen
Protman.dos Net7.cab Secur32.dll Net7.cab
Svrapi.dll Net7.cab Ndishlp.sys Net8.cab
Ndiswmi.sys Net8.cab Protman.exe Net8.cab
Ndis.vxd Net9.cab Ndis?2sup.vxd Net9.cab
Nvetbios.vxd Net9.cab Smc8020m.sys Baseb.cab

Sereinici6 e sistema bajo W98, pero continuaba sin reconocer se € servidor.




Apunte 6:

1

2)

3)

4)

5

6)

7)

14/11/2002: la semana pasada lleg6 € kit de desarrollo de ATMEL.

= Lafuente de alimentacion no viene con € kit.

= En € laboratorio existe una fuente de alimentacién para DC 12V, con un
conector que no se sabe cudl es su polaridad.

= 13cuedtion: averiguar las caracteristicas adecuadas de la fuente de alimentacion.

Debido a problema con la direccion 1P, Ismaegl me ha proporcionado una, ésta es:

193.147.161.82; no tendra problemas de incompatibilidad en la red.

» Trase cambio de direccién IP en P133 bajo W98, manteniendo €l resto de la
configuracion (DNS, puerta de enlace, méascara) igual que en Pl1350, se reinstala
latarjeta SMC EtherEZ (8416).

» Losficheros de instalacion de latarjetalos amacené en el P133, dentro del
subdirectorio “c:\mis documentos\archivos de tarjeta Ethernet”, parafacilitar la
instalacion.

* Reiniciamos el sistema.

Al arrancar W98 sigue faltando el archivo “msnp32.dilI”; W98 indique que, debido a

ello, varias de las facilidades de Microsoft Network no estaran habilitadas.

= Buscamos este archivo en e Pl1350, pero no esta (sin embargo, si funcionala
red desde ).

= Descargamos € archivo desde www.dll-files.com El archivo msnp32.zip
contiene también un readme.txt en e que se indique que se descomprima la
libreria dinamica en el subdirectorio c:\windows\system.

= Eso hice, pero, tras reiniciar nuevamente, continlia sin detectar lared. No sé cud
puede ser € fallo.

Con el kit de ATMEL se proporciona SW de desarrollo y un manual en CD del uso

del mismo y de la propia placa

= Solucién a problema de la fuente de alimentacion:
= 7-9V DC, 1A, polaridad no critica.

Se resolvié e problemaintroduciendo e CD ATMEL ARM THUMB. Posee

tutoriales autolanzables bajo € formato de hipertexto.

= Muchos de los manuales estan en .pdf: se instalara Adobe Acrobat Reader 5.0, €
cual esta disponible en el propio CD.

Ismael me ha encargado que los programas en ensamblador que (del estilo “Hello

World”) aparecen en uno de los libros de ARM sean probados en la placa del kit

bajo los diferentes entornos de desarrollo.

= Este punto necesita:
= Disposicion de una fuente de alimentacion adecuada.
= Estudio preliminar de los diferentes entornos de desarrollo en W98 y Linux.

= Luego: ambos sistemas deben estar perfectamente instalados.
» Instalacion del SW.
= Estudio de los programas g emplo y su implementacion.

SW disponible:

= Atme Arm Thumb: entorno de evaluacion de prestaciones, funcionalidad y
consumo de potencia de la placa.

= Arm Developer Suite Evaluation Version 1.1 (45 days):
=  Compiladores paraC, C++.
= Ensamblador y enlazador.
= Entorno de desarrollo integrado.

* Requisitos: Pentiumy 32 Mb de RAM.




» MetaWare High C/C++ ™ ARM: Herramienta de Desarrollo para Sistemas
Embedidos.
= Multi2000: entorno de desarrollo integrado para Atmel Arm AT91 producido
por Green Hills. Unico que funciona bajo W98SE y Linux.
8) Debido aque Linux con X-Window le exige demasiado al P133: reinstalamos
Linux, pero sdlo en modo texto.
=  Semantiene & mismo esgquema de particiones, formateando |as particiones hdcl
(ext3 /root) y hdc2 (swap).
= Sedescarta GNOME y la configuracion X-Window.
» Proceso de instalacién de paquetes...instalacién completa.
9) Reiniciamos bgjo Linux: modo terminal.
= Pretendemos configurar acceso a Internet: comando “ifconfig ethQ”.
= Pero no reconoce a“eth0” como dispositivo valido. Quizés la tarjeta Ethernet no
esté correctamente configurada bajo Linux.



Apunte7:

1) Paraconfigurar TCP/IP bajo Linux nos informamos de como esta definidaen W98,
es decir:

Direccion [P 193.147.161.82
Puerta de Enlace 193.147.161.1

DNS Primario 193.147.161.202
DNS Secundario 150.214.130.15

Nos informamos de como se usa el comando “ifconfig” bajo Linux. Linux, mediante
“man ifconfig” nos informa lo siguiente:

= “ifconfig”: configurainterfaces de red residentes en el Kernel. Su efecto se
manifiesta tras lareiniciacion del sistema.

= Opciones: “-a’: muestra €l estado de todos los interfaces, incluso de aguéllos
que se hayan caido.

= Familias de direcciones: “ifconfig interface_name family”; posibles familias:
inet (TCP/IP), inetv6 (1pv6).

= |nterfaces: “eth0”: primer interfaz de Ethernet.

Al escribir en el terminal de comandos de Linux: “ifconfig ethO” nos contesta que
ése dispositivo no existe.
2) Bajo WO8SE instalamos el SW que proporciona el Kit de desarrollo de ATMEL :

Adobe Acrobat Reader 4.0:
= C:\archivos de programa\Adobe\Acrobat 4.0

= ARM Developer Suite Evaluation Version v1.1:
= DA\SW_de Desarrollol ARM\ADSv1 1
» Actuaiza autoexec.bat guardando la version anterior como C:\autoexec.001
* Renicio del sistema.

* MetaWare Toolset for ARM 4.5%
= DASW_de Desarrollo\hcarm 4.5°
= Copiadd antiguo autoexec.bat en autoexec.old.

= CodeWright:
= DA\SW_de Desarrollo\StarBase\CodeWright
= Uso declave del producto: CW650-7X7B-68845
= Durante e proceso de instalacion se definen los siguientes parametros:

= Seusacomo compilador: Otro, no Microsoft, no Borland.

= Entornos de desarrollo integrados en CodeWright:

Si Microsoft Visual Basic
Si Microsoft Visual C++
Si Borland C++
Si Borland C++ Builder Development Enviroment
No Borland Delphi 3.2
No Texas Instruments Code Composer Studio
Librerias CodeSense instaladas:
BorlandLCiZt;rr ;I;untl me Borland OWL Library CodeWright Library
Microsoft ATL Library Microsoft MFC Library wi ndovl\i?g\ ;ly+ MSC
Java 1.2.2 Library Java 1.1.8 Library Java 1.3.0 Library

El programa de instalacion solicita donde estan situados 10s €jecutables asociados a
cada libreria; como no estan instalados, pulsamos “ Skip”.




3)

4)

5)

6)

= Multi2000 “Green Hills’:
= D)\SW_de Desarrollo\GHS
Actualizamos Linux instalando los paguetes de X-Windows junto con GNOME
(gestor de ventanas) y los productos de desarrollo.
= Objetivo: lograr configurar TCP/IP.
= Setransfieren 59 nuevos paguetes manteniendo las particionesy LILO.
Iniciamos Linux: pero se abre el modo terminal =» reinstalamos todos los paquetes
de Linux: 580 paquetes 0 1316 Mb.
Mediante el PI1350 buscamos el www.linuxnewbies.org un foro en e que me pueda
aclarar cdmo se usa “ifconfig” parainstalar una nueva interfaz de acceso alared,
esto encuentro:
= Para definir un nuevo interfaz:
= ifconfig ethO |Paddress broadcast | Paddress netmask 255.255.255.0
= route add-net default gw | Paddress
= jfconfig—a
= Paraactivarlo:
= ifconfig ethO up
Con la primera linea de comandos me responde € sistema que “eth0” no esta
definido y que no es un tipo de dispositivo; con 1o que no puedo seguir con € resto
de lineas de comando.
Sigo buscando en e mismo foro y encuentro e comando “netconfig” que
supuestamente abre una ventana de didlogo en la que se configura la conexion
TCP/IP. Tecleo “netconfig” apareciendo dicha ventana: hay cuatro campos:
direccion 1P, mascara de subred, DNS primario y DNS secundario. Los completo y
acepto. Seguidamente tecleo en e terminal “ifconfig eht0” para que muestre la
configuracién del acceso: pero no reconoce € dispositivo.
Bajo W9BSE: en & mismo foro encontré una posible solucion a problema de que no
encuentre “msnp32.dil” aunque si esté en el sistema: desinstalar |os componentes de
red y volverlos ainstalar completamente. Quizas también solucione € acceso a
Internet desde W98.
= Desingtalacion de latarjeta SMC EtherEZ (8416).
= W98 inicia autométicamente su reinstalacién, para ello solicita una serie de
ficheros que pertenecen al CD de W98SE. Como estdn comprimidos en
cabinet’s, debo extraerlos manual mente mediante WinRar. Los archivos que
solicita son:

(i) net7.cab
(c) arp.exe dhcpsvc.exe ftp.exe
icmp.dil inetmibl.dll ipcfg.dil
iphlpapi.dil msafd.dll network s
protocol Qosname.dl| rapilib.dll
rnr20.dl| Routetab.dl rpcltc3.dll
prclts3.dil Rsvpsp.dil services
smcB8000.dos snmpapi.dil vdhcp.386
vip.386 vnbt.386 vtcp.386
vtdi.386 vudp.386
net8.cab
hosts.sam ipconfig.exe Imhosts.sam
locproxy.exe locproxy2.exe nbtstat.exe
netstat.exe ping.exe minicpfg.exe
route.exe Rsvp.exe telnet.exe




telnet.hlp | tracert.exe |

net9.cab

smnc8000n.sys | wshtcp.vxd |

Descomprimimos todos estos archivos del CD de W98SE a disquete en € PII350
para grabarlos en CAmis Documentos\archivos de instalacién del P133.
» Desinstalamos la configuracion parcial que hizo W98 de la tarjeta cuando
solicité todos estos archivos (los que no solicito los instal6).
= Reiniciamos lainstalacién de latarjetaindicando € origen de los archivos:
instalacion compl etada sati sfactoriamente con todos los archivos y reinicio del
sistema.
= Enlaventana de didogo “Conexiones de Red”:
= Agregamos una conexion nueva del tipo TCP/IP.
= Seasocia ésta a EtherEZ (8416) automaticamente....OK
= Definimos los campos de la direccion IP, DNS, puerta de enlace y méscara
de subred.
= Sereinstalan los controladores de la tarjeta (todos |os archivos anteriores).
=>» pero sigue sin detectar la red.
7) Reinicio: sigue apareciendo el mensgje:
“No se puede cargar la biblioteca de vinculos dinamicos. msnp32.dil. El sistema no
puede hallar €l archivo especificado. Microsoft Network no disponible.

8) Mediante Soulseek he encontrado a tres usuarios con msnp32.dil compartido, pero
aparecen dos tipos de archivo: uno de 80 kb y otro de 84. El que estden €l P133 es
de 80 (una version anterior antendiendo a las fechas de creacion de ambos archivos).
Lo descargo a PI11350 y lo copio en €l P133, dentro de C\windows\system. Al
reiniciar el P133 sigue apareciendo € mismo mensgje.

9) En € foro de www.linuxnewbies.org aparece un mensgje gque dice que una posible
solucion a problema del mensaje de msnp32.dil es que faltan ciertos componentes
dered en lainstalacion de W98SE. Luego, aungue se copie el archivo en el lugar
especificado, no se cambia el registro de archivos de configuracion mediante
regedit.exe.

10) En “Agregar o quitar programas’ entramos en la opcion de instalacién de
componentes de Windows. Seleccionamos los siguiente a afadir:
= Del apartado “Comunicaciones’ seleccionamos todos |os paguetes.

» Del de“Herramientas de Red” se afade:
= Conexion compartida a Internet.
=  Web-Based Entreprise Management.

=>» alahorade instalar estos paguetes W98 me remite al CD de instalacion. Como en €l

todos los archivos estan comprimidos, no son accesibles directamente. Son demasiados

los archivos solicitados como para instalarlos manualmente uno a uno -
e\w98\instalar.exe.
11) Reinstalacion de W98:
= Comprobacion del sistema:
= ScanDisk: W98 no se cerr6 correctamente.
= Buscar componentes instalados.
= Comprobando s existe suficiente espacio en disco.

»  Guardamos por seguridad |os archivos asociados a la configuracion actua de
WOBSE en D:\; en total alcanzalos 110 Mb.

= Generacion de disco de inicio W98.

= Copiadelosarchivos.

12) W98 sereinicia por 12 vez:




= error de protocolo O.
= error 6715: e nombre del grupo de trabgo ha de ser distinto que el del PC.
Este problema se abordard mas tarde.

13) Probamos si W98 puede conectarse a lared: Si.



Apunte 8:
21-11-2002
1) Instalamos Linux nuevamente, pero sin X-Window: en modo texto.

Pretendemos actualizar €l sistema para evitar la instalacion de todos |os paquetes

de ladistribucién; tan solo se pretende que la opcion, tras €l inicio del sistema,

sea el modo intérprete de comandos.

Iniciamos lainstalacion con el CD1 de la distribucién de Linux:

=  Mantenemos la estructura de particiones de los HD'’s y € gestor de arranque.

» Linux comienzala blsqueda de paquetes a actualizar > no encuentra
ninguno.

= Durante € proceso de actualizacion no aparece la opcion que defina e modo
texto como e modo por defecto del sistema.

Problema: el modo por defecto, tras este punto, es el de X-Window.

Solucién: instalacién completa sin los paquetes asociados a X-Window.

2) Arranque de W98:

Al arrancar no muestra que necesita “msnp32.dil”.

Pretendemos configurar laimpresora, pero no conozco laruta de red de la

misma:

= W08 solicitalos drivers que estan en el CD de W98SE, pero al estar
comprimidos en .cab no son accesibles directamente.

= Nomehetraido e CD de W98SE.

= Solucion: actudizar € sistema desde v4.windowsupdate.microsoft.com.

Instalamos la version de evaluacion de Norton Antivirus 2003, |o descargamos

de www.symantec.com, quedando registrado hasta el 22-11-03. Generamos los

discos de rescate en D:\Rescue.

3) Adquisicion de fuente de alimentacién para la placa de ATMEL.

Especificaciones:

= Tension de salida programable: 4.5V, 7.5V , 9V, 12V.
= Corriente de salida: hasta 1300mA.

Falta confirmar la garantia.

4) Adquisicion de dos destornilladores. uno de estrellay otro plano.

5) Busqueda de informacion sobre FCS para mejorar la estabilidad de vuelo y
disminuir la carga del piloto.

6) Problema: € kit viene con un cable serie para conectar laplacaa PC, pero e P133
no posee puerto serie libre. Solucion: el PI1350 si posee puerto serie libre, en é
tendremos que trabajar. Trabajar con Linux va a quedar subyugado ala condicion de
gue se disponga de otra placa madre para PC gque tenga un puerto serie libre.

22-11-2002.

1) Instalamos en & PI1350 & software de desarrollo que traia el kit de ATMEL:

ARM Developer Suite V1.1 Evaluation Version.

= Directorio destino: D\SW_FCS\ ARM\ADSv1 1.

= Problema: € gestor del fichero de licencia del software me indica que éste
esta corrupto. Solicita que se descargue desde el servidor del proveedor del
software.

= Solucién: se descarga de Internet un gestor de licencia nuevo, pero sigue
estando corrupto. No se soluciona el problema.

25-11-2002.

Multi2000 de “ Green Hills.
= Directorio destino: D\SW_FCS\GHS.



» Indicaque parasolicitar al fabricante lalicencia se gjecute “License
Generator”.
= MetaWare Toolset for ARM 4.5%
* Directorio destino: DASW_FCS\hcarm 4.5%
= Nombre de Usuario: Sergio Latorre.
*= Nombre de Compariia: EsCuela de InGenieros — Proyecto AEROL FCS.
= CodeWright IDE:
= Directorios de destino:
= DASW_FCS\hcarm_4.5*\CodeWrightinstall
= DASW_FCS\Starbase\CodeWright
= Instalamos las librerias “ Code Sense”.
= Mismo nombre de Usuario y de Compafia que en €l caso anterior.

2) Instalamos completamente el Linux en P133, saltandonos la configuracion de X-
Window. Se mantiene la estructura de particiones, formateando las asociadas a
Linux, y el gestor de arranque. El nimero de paquetes ainstalar es menor que i se
incluye la configuracion de X-Windows. Se definen dos usuarios:
= /root: administrador del sistema, cuya clave es: mustek11.
= serlat: usuario ordinario, cuya clave es. mustek11.
= El modo de arrangue es ahora: texto.

27-11-2002.

1) Seguimos la recomendacion mediante “ Getting Started” del CD de ARM:

a) Arrancar y probar la placa de evaluacion.
i) Comprobar laposicion del jumper JP1 en STD (standard)....OK
i) Alimentar la placa:
(1) Conectamos la fuente (programada a 9v*) ala placa....OK
(2) Conectamos la fuente alared eléctrica....OK
Interruptor en ON =» Error: la placa no responde.
(3) OFF y desenchufamos la fuente de la red el éctrica.

(@) El transformador huele a sobrecalentamiento. Lo abrimosy
observamos que la clavija de salida, interiormente, esta en corto
consigo misma....la chapita estaba doblada.

(b) Ladesdoblamos con ayuda del destornillador plano, sobre €l cual
salta un arco voltaico que descarga a transformador de la fuente.

(4) Enchufamos el transformador alared eléctricay ON.
(& LED’sdelaplacade encienden simultaneamente: de D1 a D11.
(b) Tras unos segundos se apagan de D2 a D9 - boot completado: OK.
(5) OFF.
b) Iniciar la prueba de las funciones de la placa (“on-Board Functional Test SW”).
i) Conectar cable serie entre |os puertos serie A y B.
=>» problema: |os conectores de |os puertos en la placa estdn demasiado juntos
como para que se pueda enchufar los dos extremos del cable simulténeamente.

=>» solucion: con ayuda del destornillador plano cortamos una capa del borde
de plastico de los extremos del cable serie. Se consigue enchufar ambos
extremos.

ii) Mantenemos pulsado SW1y ON =» no responde la placa.
(1) El problema no esta en €l transformador, ya hemos arreglado los falsos
contactos.

! seglin ARM la placa puede ser alimentadaentre 7y 9V, con 1000 mA.



(2) Movemos ligeramente el conector J1 que alimenta la placa. Hacia mal
contacto.

(3) Seiniciael arranque satisfactoriamente:

(&) Desde D1 a D11 parpadean unavez; se suelta SW1 ta y como indica
larecomendacion de ARM, iniciando “Functiona Test”.
(b) De D1 a D5 parpadean 1 vez: test pasado OK.
iii) OFF.
c) Conectamos el PC (COM1) alaplaca (SERIAL A) mediante €l cable serie.
d) Instalamoslalibreria AT91 en e PC para ADS v1.1:
i) Extraer e archivo zip con lalibreriav2.10 desde del CD de ARM.
(1) Sefuerzapor programaa que se extraiga sobre C)\.
i) Iniciamos ADS v1.1:
(1) Seintentaabrir CodeWarrior for ADSv1.1:
(& =>» Error: archivo de licencia corrupto.
(b) =» Solucién: bajarlo de Internet como aconsgja el gestor de la
licencia.
(1) http://www.c-dilla.com/support/Ims.html
(i) ftp://ftp.macrovisioneruope.com/outgoing/cdalms.exe
(c) = Error: d gecutar cdalms.exe muestra el mensaje de error:
“(1615:6): usuarios de Windows NT deben comprobar |os derechos
de acceso con € Administrador. Si € problema persiste, reinicie su
(d) =» Soluciodn: reiniciamos €l PI1350 y reinstalamos €l producto ADS
v1.1 (Evaluation Version).
(e) =» Error: mismo error que antes.
€) Instalamoslalibreria AT91 en el PC para MULTI2000:
i) Extraemos lalibreria AT91 sobre C\ desde el CD de ARM.
i) Iniciamos Multi2000:

(1) = Error: mensge: “Unable to get license for multi: Failure 100:
Network error: Unable to send messages to license software: No such a
file o directory.”

28-11-2002.
1) Buscamos en € manua de la placainformacion relativaa consumo de la placa.
a) Motivo: mi profesor tutor |0 necesita para hacer un calculo rapido sobre las
baterias de alimentacion que se montaran en el Helicoptero.
b) Datos de la placa segun “User Guide”:
i) DC7V -9VylA.
i) Medidade consumo de corriente en tiempo real:

(1) Mediante jumpers JPSA/B (Vppio) Y JP7A/B (Vppcore)- Permite
conectar un amperimetro directamente. Referencia en pagina5-3y 32/39
de “User Guide’ parala placa EB40a.

2) Solucion a problemade Licenciade ADS v1.1:
a) Desintaar laversion v1.1 actual.
b) Del CD1 7-10-2002 se descomprime la version v1.2 (que es completamente
funciona).
i) Directorio destino: D:\SW_FCS\temporal.
ii) Directorio origen:
E:\\AT91\Entorno de Desarrollo Windows\ARM _developer_suite vl 2.rar.

c) Trasladescompresion se genera dentro de “..\temporal” €l subdirectorio
“..\ARM .developer.suite v1.2".




3)

4)

5
6)
7)

i) Ejecutamos “setup.exe” de ese subdirectorio.
(1) Directorio destino de instalaciéon: D:\SW_FCS\ARM\ADSv1 2.
(2) Opcidn de Instalacion: completa.
ii) Instalando componentes...OK.
d) Estudio de puesta en funcionamiento del crack:
i) Subdirectorio: ..\temporal.

(1) Segun “install.txt”: tras lainstalacion, a empezar “ARM License
Wizard”, se selecciona “instalar licencia’ abriendo €l archivo
“.\crack\license.dat”.

ii) Traslainstalacién de componentes se abre “ARM License Wizard”:

(1) Browse: se abre por defecto en D\SW_FCS\AARM\ADSv1 2\Bin para
buscar “license.dat”. Copiamos “..\crack\license.dat” en esa carpeta.

(2) Leindicamos a gestor de lalicencia que en €l fichero
“DASW_FCS\ARM\ADSv1 2\Bin\license.dat” esta lalicencia vélida
ignorando e campo del codigo de acceso (Io dejamos en blanco).

(3) Pulsamos “Next” aceptandose la licencia proporcionada.

(4) Sepreguntasi lalicerciadada el temporal 0 permanente: indicamos que
es permanente. Pulsamos “Finish”.

(5) Mensgje ddl instalador: “ADS v1.2 esta instalado completamente.

e) Comprobamos que ADS 1.2 se abre correctamente...OK.

Instalacion de librerias AT91 en el PC para ADS1.2:

a) Extraemos desde el CD de ARM las librerias en C\.

b) Mediante Metrowerks CodeWarrior for ADSv1.2 abrimos la libreria de nombre
C:\AT91\Software\partsr40008\r40008_lib16.mcp.
i) Debido aque lalibreria proporcionada por ARM esta disefiada para ADSL. 1,

ADS1.2 la actueliza correctamente.

c) Seleccionar todos los paquetes de la libreriay MAKE desde CodeWarrior.
i) Seiniciael compilado de todos los paguetes dando O erroresy 1 aviso.

(1) Seguin recomendaciones de ARM, €l aviso lo ignoramos.

ii) Secierrad proyecto y laventana de errores/avisos.
Reconstruir la biblioteca de controladores de ARM ® para ADS1.2:
a) Abrimos con CodeWarrior: c\at91\software\drivers\lib_drAlib_drv_16.mcp.
b) Actualizacion automética a la Gltima version.
c) Seleccionamos MAKE: compilandose todos los archivos sin errores ni avisos.
Reconstruir un proyecto gemplo: led swing...OK
Recongtruir la libreria Tools...OK
Descargar un programa estandar en la placay gecutarlo:
a) Al depurar aparecen 2 errores. mensgje: no se encuentralalibreria
r40008_libl6.a.
b) =» No se puede descargar hasta que no se depure correctamente.



Apunte 9:
15-2-2003:

1

2)

Del P133 han retirado los HD’s. no se reconoce ningun HD en el proceso de
arranque del sistemani S.O. valido. Utilizo € disquete de arranque de W98 e inicio
el sistema, el cual no detecta ningiin HD en la méquina. Menos mal que todo € SW
gue en este PC estabainstalado y que me fuera Util para €l proyecto estaba instalado
en e PII350.

Del PI1350 no han modificado nada, por o menos a lo referente a mi cuenta.

a) Renuevo la contrasefia de la cuenta: Mustek11.

b) Lacuentasigue todavia activa.



Apunte 10:
20-2-2003:
1) Objetivos:

a)

Chequeo del funcionamiento de la placade ATMEL.

b) Llevar acabo todo e “Getting Started” que proporciona el fabricante.
2) Planteamiento: Getting Started:

a)

Insertamos el CD de ATMEL: ARM Thumb

b) Plantea dos paguetes de SW:

f)

9

i) Green Hills: que nos da problemas de no validacion de la licencia; con lo
gue no podemos trabajar con 4.
i) ARM ADSv1.2: € cua yaestdinstalado en € PI1350 y funciona
correctamente.
Seleccionamos la opcion: ARM ADS — ANGEL : esta opcion incluye el SW que
trae consigo la placa dado por € fabricante ATMEL.
Inicio y Prueba de la placa de Evaluacion.
i) Configuraciéon y Alimentacion correctas. JP1 en STD y VDD = 9V.
ii) Arranque completado:
(1) D1,D2,...,D11 seencienden inicidndose € chequeo interno de la placa.
(2) D1,D10y D11 permanecen encendidos: chequeo OK.
i) Inicio del SW de prueba de sistemas en la placa. Para ello se llevan a cabo
|as siguientes operaciones.
(1) Conexion del cable serie entre Serial A y Seria B: OK
(2) Apretamos el boton RESET y SW1.
(3) Soltamos SW1 iniciandose la prueba de sistemas.
(@ D1,D2,...,D5 parpadean solo 1 vez consecutivamente.
(4) Chequeo de sistemas. OK
Instalacion de ARM Developer Suite (ADS) v1.2: ya estaba instalada.
Conexién del PC alaplaca:
i) Apagar laplaca
ii) Conexion desde Coml del PC a Serial A de laplaca.
Instalacion de lalibreria AT91 proporcionada por el fabricante:
i) Extraccion de lalibreria
(1) Auto — Extraccion en C\
(2) librerias en Chat91\software\.....OK
if) Reconstruccion de una libreria de dispositivo con ARM v1.2:
(1) Abrimos “Metrowerks CodeWarrior for ADS v1.2":
(2) Abrimos un nuevo proyecto:
(& c\at91\software\partswr40008\r40008_lib16.mcp
(b) Incidencia: el programa solicita la actualizacion del proyecto y de
todos los archivos asociados a la Ultima version de ADS. Aceptamos.
(3) En “Targets’ se seleccionan todas las variantes (Edit > Select All)...OK
(4) Project > Make...no aparece ninguna ventana de error: OK
iif) Reconstruccion de un proyecto de lalibreria AT91 con ADS: “Led Swing”:
(1) File > Open...
(& c\at91\software\projects\led swing_eb40a\led_swing.mcp
(b) Se actualiza a la Ultima version todos los componentes del proyecto.
(2) En “Targets’ seleccionamos todas las variantes para compilarlas.
(3) Project > Make...ERROR: no encuentra la libreria r40008 _lib16.a
(& Solucion: buscamos el archivo con Windows, € cua estaen:



h)

(i) c\at91\software\partsr40008\r40008 _|lib16 Data\optm full\r40
008_lib.a
(i) En la pestaiia “Files” se incluye esta libreria.
(b) Project > Make...OK: devuelve informe del resultado
(4) File > Close...Cerramos €l proyecto.
iv) Reconstruccion de lalibreria“Tools” con ADS:
(1) File > Open: abrimos un proyecto de:
(@ c\at91\software\tools\flash_downloader\flash 16x4\flash_16x4.mcp
(b) Actuaizacién ala Ultima version...OK
(2) En la pestafia “Targets’ se selecciona “int_sram”.
(3) Project > Make...OK: informe del proceso.
Descarga de un programa standard a la placay gecutarlo en ella
i) File> Open: c\at91\software\projects\led_swing_eb40a\led swing.mcp
i) En“Targets’ se aplicaEdit> Select All y Project>Make
(1) 17 Errores. simbolos indefinidos. De las 4 variantes |os 17 errores
aparecen a compilar la variante “flash”; esto lo hemos averiguado al
compilar cada variante independientemente.
(2) Decision: sigamos adelante con los errores.
iil) Alimentamos la placa e inicio de chequeo automético...OK
iv) Project-> Debug:
(2) Inicio del depurador AXD (en ventana propia). Configuracion por
defecto:* ARMulator ADS v1.2 (Build 805)” en el registro del depurador.
v) Configuramos el depurador:
(1) Options—~> Configure Target...(dentro de AXD).
(2) Selecionamos. configure APD...OK
(3) Seleccionamos “serial driver” para su configuracion. Es €l puerto de
comunicaciones entre el PC y la placa.
(4) Configuramos la conexién: COM1, 38400 bps.
vi) En € registro del depurador (RDI Log) aparece: “Angel Debug Monitor
(serid) for at91eb40a’.
vii) Execute - Go: dos veces:= Los Led' s parpadean formando una onda....OK
(1) El puerto serie Seria A registra actividad como lo atestiguan los leds
TX_ Dy RX_D.
viil)  Execute - Stop: detenemos € programa...OK
Grabar “Led Swing” en lamemoria Flash de la placay gecutarlo en dla.
i) AVISO: JP1en USER: evitamos sobreescribir sobre |os primeros sectores
de lamemoria Flash.
(1) Conmutamos &l Jumper 1 (JP1) de STD aUSER...OK
i) En AXD: File>Load Image...
(1) c\at91\software\tools\flash_downloader\flash 16x4\flash_16x4 Data\int
_sram\flash_16x4.axf...OK
(2) Aparece & mensgje: ¢reemplazar laimagen cargada?...Damos OK
iii) Execute > GO (2 veces)
Enla“Console’ aparece: “*** Load Address ***”

(1) Escribimos: “0x1000000".
iv) Enla“Console” aparece: “***File Address ***”
(1) Escribimos:” c\at91\software\projects\led swing_eb40a\led swing_datal
flash\led _swing.bin” y return...OK
(& ERROR: “Cannot open file image” como mensgje en “Consol€e’.
(b) Solucion: buscar €l archivo .bin con € Windows.



Apunte 11:
21-2-2003:

(2) Retomamos, desde €l arranque de la placa hasta e punto anterior, en
proceso de descarga en flash de un coédigo y su gecucion en laplaca. La
ARMT7TDMI-Console sirve para interactuar con €l micro de la placa
mediante programa a usar “printf” y “sscanf”.

(3) buscamos €l archivo led swing.bin con Windows:. se encuentraen la
ruta:c\at91\software\projectsiled_swing_eb40a\led_swing_Dataflash\le
d_swing.bin. Puesto que en el manual “ Getting Started” aparece
“led_swing_data’ con mintscula; probamos aindicarle con mayusculala
ruta del archivo a encontrar por s distingue entre mayusculas y
minusculas.

(4) Aparece en la consola un mensaje de error porque no existe tal archivo.
Estudiamos el cédigo fuente que gestiona la consola; en él aparece:
“imagen=fopen(name,’rb’)” devolviendo NULL.

(5) Estudiamos la sintaxis de “fopen”; para ello nos documentamos en
http://c.conclase.net/ficheros/ficheros002.html, en donde aparece: “FILE
*fopen(char * nombre, char *modo)” siendo:

(@ ‘r': sdlo lectura: exige que exista e fichero.
(b) *b’: tipo binario.
v) File > Exit.
vi) Apagamos la placay la arrancamos en modo usuario (JP1=USER) =» los
led's estén oscilando...OK el programa habia sido descargado ala memoria
flash de |a placa satisfactoriamente.

3) Objetivo:

b)
c)

f)

9

Disefiar un programa de prueba tipo “Hola Mundo”.

Descargarlo a la flash de la placa.

Ejecutarlo en ella.

Nota

- Al iniciar la placa sempre en modo JP1=STD.

- Al cargar unaimagen en flash: slempre en modo JP1=USER.

- Al cargar unaimagen en sram: en modo JP1=STD.

= Definir el objetivo en AXD s aparece el modo ARMulator (vertana de
LOG).

Se arranca la placa en modo JP1=STD.

Abrir CodeWarrior for ADS v1.2.

File>New:

i) Pestafia“Project”: optamos por ARM Executable Image de entre las
opciones de proyectos nuevos.

i) Ruta: c:\Documents and Settigs\serlat\Mis documentos\Codigos fuente\.

iif) Nombre el proyecto: Hello World.mcp...OK

Definir “Input Files to link”: pulsamos € botén “new text file”.

i) Seabre unaventana en la que se puede escribir e codigo C++.

ii) Escribimos € codigo y lo salvamos como: “...\Cédigos fuente\Hello
World.c’.

Project-> Add Hello World to project...OK

i) El archivo .c yaforma parte del proyecto en curso.

Make...Se abre una ventana de Errors and Warnings: los errores son corregidos

satisfactoriamente...OK

Make...OK: se presenta e informe del resultado.



h)
i)

JP1=USER.

Debug:

i) Seabre AXD; el cua descargalaimagen: led’s de puerto serial A activada.
ii) Execute>Go: en la ventana de consola aparece € texto "Hello World”...OK

4) Objetivo:

a)
b)
c)
d)
€)

f)

Disefiar un programa de prueba que genere, iterando, los 10 primeros términos
de la serie de Fibonacci.

Descargar € codigo en flash y gecutarlo.

Se enciende la placa en modo JP1=STD.

Escribir € codigo abriendo un nuevo proyecto y la ventana de texto.

Guardar €l cddigo en: ...\Cddigos fuente\fibonacci.c.

JP1=USER.

Debug...OK

Execute 2 Go. Se presenta por pantallalos 10 primeros términos de
Fibonacci...OK

22-2-2003.
5) Objetivo:

a)

Disefio de Banco de Pruebas para uC de placa

= Tratamiento con enteros.

= Tratamiento con flotantes.

= Medidas de tiempo de proceso (uso del tiempo de sistema).

=>» Determinacion del peso de computo limite segun el tiempo de muestreo.
Andlisis de Problematica:

Desarrollo de rutinas que involucren e tratamiento con enteros o con flotantes.
Planteamiento:

b)

Para Flotantes:
» Generacion aleatoria de secuenciade N valores.
= QOperaciones simples. sumas y multiplicaciones sobre la secuencia.
» Cdlculos Estadisticos. Media, varianza y superiores. Limite en €l orden.
» |nversion de Matrices: limite en €l orden.
Para enteros. limite en el nUmero de operacionesy en e orden dd filtro.
= Concretamos los algoritmos de flotantes para enteros, en |0s casos gque esto
sea posible.
= Implementacion de ecuaciones en diferencias de sistemas estables con
estados posibles bajo aritmética entera.
= NUmero de operaciones. sumas, multiplicaciones.
Medida del peso del computo: niimero de operaciones/ tiempo de operacion.
NUmero de sumas, multiplicaciones para enteros y flotantes.
NuUmero de lecturas/escrituras: estudio del codigo ensamblador (ARM Thumb)
asociado a las operaciones sobre enteros y flotantes.

Para ello se desarrollan mutinas simples que midan e tiempo consumido por una
serie de caculos repetitivos (mejor medida que un Unico calculo), sean sumas,
multiplicaciones, lectura de registro y escritura de registro. Exige € estudio de las
funciones de gestion del tiempo del sistema que proporciona ADS v1.2.

C)

Presentacion de informe de resultados.

6) Objetivo:

Estudio del Sistema: diferentes planteamientos de observacion, estimacion y
control del sistema dinéamico.

Aplicacién de las medidas de tiempo para la cuantificacion del consumo de cada
planteamiento para su posterior discriminacion.



= =>» Informe comparativo de diferentes métodos segin consumo de computo.
a) Andlisisde problema: diferentes planteamientos (no excluyentes).
i) Problema de Identificacion de sistemas.
(2) identificacion en linea - control adaptativo.
(2) Método de minimos cuadréticos:
(@) recursivo (on-line).
(b) no recursivo (off-line).
(3) Método de minimos cuadrados ponderados: factor de olvido.
ii) Problema del Regulador de Minima Varianza: autosintonia (control
adaptativo).
iif) Problema del Regulador LQR. (off-1line): obtencion del horizonte infinito.
iv) Problema de Observadores: filtro de Kalman (LQG).
v) Problema MPC: Model Predictive Control.
vi) Control Adaptativo: autogjustable.
(1) Bucle abierto.
(2) Bucle cerrado.
vii) Esguema de bloques:

Referencia Salida
Controlador Planta

Observador

Error

Mecanismo
de Ajuste

MODELO

b) Identificacién de Sistemas: Método de Minimos Cuadrados.
i) Estudio de sistema monovariable:
(1) Convergenciay factor de olvido: estabilidad.
(2) Tiempo de muestreo.
(3) Medidas de Consumo de cémputo: conteo del nimero de operacionesy
relacion con e consumo/operacion.
ii) Extensién a sistema multivariable:
(1) Definicién de sistemas multivariables mediante ecuaciones en diferencia.
(2) Factor de olvido multivariable.
(3) Definicion de Supermatriz de covarianzas (triple indice: filas, columnas,
profundidad).
(4) Definicion de Supermatriz de parametros estimados.
(5) Estudio de convergenciay factor de olvido.
(6) Tiempo de muestreo.
(7) Medidas de Consumo de computo.
¢) Regulador de Minima Varianza.



Apunte 12

12-3-2002:

1) Objetivo: realizacion practicadel punto 5.a) del dia 22-2-2003 (Apunte 11) para €l
tratamiento de flotantes. Todos los cédigos se han probado en un PI1350 de
sobremesa.

a) Dentro del proyecto “bancoDePruebas’ se elaboran las siguientes rutinas:

i) Inicializacion de unatabla con muestras de la variable aeatoria U(0,1).
Sobre ella se aplicardn los bancos de pruebas de sumay producto.

ii) Uso de bucles “for” pararecorrer latablay operar.

iil) Estudio de las funciones de gestion de tiempo de Windows, habiéndose
encontrado:

(1) void gettime(struct time t); Esta funcion inicializa la estructura time con
lahora actual del sistema. Siendo:
struct time{
unsigned char ti_min; //minutes
unsigned char ti_hour; //hours
unsigned char ti_hund; //hundredth of second
unsigned char ti_sec; //seconds
};
Esta funcidn se encuentra en la libreria “dos.h”.

iv) Se haeaborado lafuncion “float tiempoSistema(float * tiempo); devuelve el
tiempo del sistema en segundos, sobre la variable “tiempo”, con una
precision de centésima de segundo.

b) Tabla de medidas de tiempo:

(i) N°demuestras Tiempo de Suma () Tiempo de Producto ()
10000 0.06 0.05
30000 0.17 0.16
50000 0.28 0.27
100000 0.55 0.55
500000 2.69 2.69
1000000 571 5.49

Notas sobre resultados:

i) Seinvierte gran parte del tiempo de procesado en lareservadindmica de la
tabla de muestras aeatorias. La reserva se hace de una sola vez, siendo o
practicable en el sistema uC; por lo tanto se realizara la generacion de las
sucesivas muestras aleatorias en linea, es decir, ala par que se opera con
ellas.

ii) Gran parte del tiempo computado se debe a operaciones de lectura/escritura,
tal y como se demuestra observando el cddigo ensamblador asociado. Una
solucién es no tratar con muestras situadas en una tabla, sino ir generandolas
conforme se necesiten.

¢) Lasmodificaciones se contemplan en el proyecto “bancoDePruebas2.exe”. Cuya

tabla de medidas de tiempo:
(i) N°demuestras Tiempo de Suma () Tiempo de Producto ()
106 11.21 10.76

Problematica: La doble llamada ala funcién VA() para que genere valores aleatorios
ralentiza marcadamente el tiempo de computo; e cual no esta asociado, en mayor
medida, al tiempo de proceso.




d) Solucion: hacer 1 llamadaaVA() con € nimero méximo de cifras significativas
gue permitala codificacion del formato “int” y operar con esa muestra repetidas

VECes.

i) Calibramos el nimero maximo de cifras significativas a 9, con mas cifras
significativas € valor de “rango” no es coherente. Véase funcion

“diezElevadoA” de “bancoDePruebas3.cpp”.

€) Lasmodificaciones se observan en €l proyecto “bancoDePruebas3.exe” cuya
tabla de medidas es la siguiente:

NC de operaciones

Tiempo de Suma ()

Tiempo de Producto ()

1005 0 0
5*10"5 0.49 0

1076 0.27 0
5*10"6 0.71 0.17

1007 0.77 0.33
5*10N7 2.17 1.48

1078 3.52 3.02

10M9 30.98 30.32

Se observa que:

i) para<10"6 lainfluencia multitarea por division en tiempo de Windows es

manifiesta.

i) >5*10"7: estainfluencia va desapareciendo por tiempos promedios.

iil) En € codigo ensamblador asociado aparecen las instrucciones que
implementan € bucle “for”, ademas de las propias para sumar flotantes
“fadd” y para multiplicar flotantes “fmul”. Midamos cuénto tiempo
consumen estas instrucciones: para ello se dgjan como comentario las

instrucciones relativas a procesado de datos.

f) Las modificaciones se observan en el proyecto “bancoDePruebas3 1.exe” cuya
tabla de medidas es la siguiente:

N° de oper aciones

Tiempo de Suma (s)

Tiempo de Producto ()

10M7 0.77 0.16
10"8 2.36 1.81
5*10"8 9.88 9.28
10"9 19.33 18.56

Para mas operaciones el efecto multitarea es minimiza, sobre todo cuando se procede
a cerrar todas las aplicaciones que corren bajo Windows salvo las del sistema.
i) Atendiendo alos datos:

N° de operaciones

Tiempo de Suma (s)

Tiempo de Producto ()

10"9

11.65

11.96

ii) Paralasumaseinvierte e 37.6 % en las operaciones.

iii) Paraé producto seinvierte e 39.45 % en las operaciones.
g Estosalgoritmos han de probarseen el uC de ATMEL; paraello se han de
buscar las rutinas de acceso al tiempo del sistema propias del micro.




Apunte 13:
13.3.2003:

1

2)

3)

1)

2)

Objetivo: Probar “bancoDePruebas3” y “bancoDePruebas3 1" en uC de ATMEL.

Para ello serequiere:

a) Adaptar las rutinas de deteccion y gestion de tiempo del sistema a la arquitectura
del micro ARM7TDMI de ATMEL.

Problemética:

a) He conectado € transformador alaplacay alared.

b) He arrancado la placay ha gecutado e chegqueo interno correctamente.

i) jEl transformador se ha calentado en exceso!
i) Lo desenchufoy lo abro con & destornillador: El transistor de potencia que
tiene ala salida parece abollado. Vuelvo a cerrarlo.

c) Lecomento estas incidencias alsmael por correo.

d) Paracomprobar e funcionamiento del transformador medimos con un
voltimetro la salida del mismo cuando esta conectado alared y sin carga.
(Espero a que se enfrie previamente). =» el transformador da 0.0V alasalida.

Solucién: hablo con Ismael y decidimos comprar otro transformador (mafiana iré):

a) Tienda “M. Ledn”; c/Castilla

b) A cuentadd “Departamento de Automética’ y a nombre de “Ismadl Alcald’.

c) Entregar el albardn alsmadl.

Objetivo: Busqueda de librerias y rutinas de gestion de tiempo en C++.

a) El uC de ATMEL es compatible con las rutinas de ANSI C; siendo éstas
mejoradas para el propio micro, tal y como lo aseguran los manuales de ADS.

Bibliogr afia:

a) Titulo: “ANSI C asu alcance.”

i) Autor: Herbert Schildt.

ii) Editorial: Osborne/ McGraw-Hills.
iii) 1SBN: 84-7615-603-0.

iv) Funciones asociadas:

clock_t clock(void);

» Compatible conANSI C eincluido en “time.h”.

> Devuelve el nUmero de ciclos de reloj del sistema desde el comienzo de
gjecucion de la aplicacion que lallama. Paratransformar el segundos se divide €
resultado por lamacro CLK_TCK.

» El tipo clock_t = long unsigned int.

> Pagina4009.

time_t time(time_t *hora);

Compatible con ANSI C eincluido en “time.h”.

Devuelve € tiempo del sistemaen e formato “horadel calendario”.

time_t = long unsigned int.

Si hora==NULL.: devuelve € tiempo del sistema.

Si horal=NULL: ademas, inicializa el puntero dado con el tiempo del sistema.

Pagina 413.

ouble difftime(time_t hora2, time_t horal);

Compatible con ANSI C eincluido en “time.h”.

Devuelve hora2 — horal en segundos.

Pagina 411.

Titulo: “Borland C++: Manual de Referencia”

i) Autor: Herbert Schildt.

ii) Editorial: Osborne/ McGraw-Hills.

QYVVVVY
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iil) 1ISBN: 84-481-1141-9.
iv) Funciones asociadas.
long biostime(int orden, long nuevaHora);
Pertenece a “bios.h”, no compatible con ANSI C.
Lee o escribe € reloj del sistema; siendo la hora dentro de cada dia a partir de
las 0:00 am.
Si orden==0: devuelve €l vaor de lahoradel sistema en ticks.
Si orden==1: devuelve €l valor de la hora dada por nuevaHoray la escribe en €
reloj del sistema.
Pagina 393.
void delay(unsigned time);
» Pertenece a*“dos.h”, no compatible con ANSI C.
> Detiene la gjecucion de un programa durante time (ms).
» Funcion relacionada: sleep().
» Péagina 399.
void ftime(struct timeb *hora);
» Pertenece a“sys\time.h”; no compatible con ANSI C.
» Pagina41l7.
int kbhit(void);
» Pertenece a “conio.h”; no compatible con ANSI C.
> Pagina43l.
void sleep(unsigned time);
» Pertenece a“dos.h”; no compatible con ANSI C.
» Suspende la g ecucion del programa durante time (segundos).
> Pagina44l.
void exit(int estado);
» Pertenece a“stdlib.h”; siendo compatible con ANSI C.
> Devuelve lagecucion a sistema operativo.
» Si estado == 0: terminacién normal. (EXIT_SUCCESS).
» S estado == 1. EXIT_FAILURE.

Y VV VYV

» P&gina73.
Uso de variables globales en archivos compilados por separado:
» Archivol: » Archivo 2:
int X,y; extern int x,y;
char c; extern char c;
main(void) void func21(void)
{ {
x=y/10;
}
void funcl1(void) void func22(void)
{ {
X=23, y=10;

} }



Apunte 14.

14.3.2003:

1) Objetivo: Comprobacion del correcto funcionamiento del transformador nuevo.
Para ello se llevan a cabo las siguientes medidas:

Valor Programado de Tensién (V) Valor medido (V)
4.5 6.40
6 7.81
7.5 9.52
9 11.30
12 14.85

L as medidas se hicieron en abierto, con € transformador descar gado.

a) Lasmedidas se hicieron en orden creciente de voltaje para evitar la carga parcial
del bobinado secundario alterdndose el valor de la medida
b) Entre medidas se apag6 € transformador (punto rojo del interruptor oculto).
2) Objetivo: Repeticion de las medidas para6, 7.5y 9 V programados conectando la
placadel uC de ATMEL, se obtiene la siguiente tabla:

ValorTg](;ggr?T\;’:l)do de Valor medido (V) Notas
6 7.05 Chequeo OK
7.5 8.61 Chequeo OK
9 10.44 Chequeo OK

Objetivo: Repeticion de las medidas para 6, 7.5y 9 V programador con la placa
conectada y gecutando “led_swing’.

Va“’rTanoggé r?T\j‘)do de Valor medido (V) Notas
6 7.05 Chequeo OK: LEDs bailando
7.5 8.75 Chequeo OK: LEDs bailando
9 10.20 Chequeo OK: LEDs bailando

DECISION: El transformador se programara a6V (dandose 7.05 V).

3) Objetivo: adaptar al standard ANSI C el cédigo del “bancoDePruebas3 1.cpp”.
4) Resultado: codigo “bancoDePruebas3 5.cpp”. Hay que probarlo sobre € uC de
ATMEL (funciona en PI1233).




Apunte 15:
20.3.2003:

1)
2)

Objetivo: Depuracion del proyecto “bancoDePruebas3 5.cpp”:

Para ello hacemos lo siguiente:

Excluimos del proyecto “bancoDePruebas.mcp” el fichero bancoDePruebas3_2.cpp

e incluimos el bancoDePruebas3_5.cpp.

Encendemos el uC habiendo programado €l transformador a6 V previamente.

Conmutamos el JP1 de STD a USER.

Depuramos €l codigo: carga de laimagen correcta.

=  Processor Views = Source...: se selecciona €l fichero .cpp.
= Paradepurar aparece €l cddigo ensamblador y €l C++.
= Nota € tiempo devuelto € siempre un entero (multiplo del segundo), como

S no tratara con partes del segundo.

Se define un nuevo proyecto (imagen gecutable): bancoDePruebas3 5.mcp.

Descargamos la imagen en modo usuario.

= No se logra saber € valor de “time” a depurar. No me permite el debugger
definir un watch con dicha variable.

= Probamos con diferentes nimeros de operaciones para asegurar gue se tarde mas
de un segundo en su gjecucion. Los ticks que se devuelven son siempre mdiltiplo
de 100.

= Para que eventos puntuales no afecten en demasia al resultado de la medida de
tiempo de proceso elevamos lo suficiente e nimero de operaciores. Mediante
diversas pruebas, se constata que se requiere de un minimo de 100 millones de
operaciones.

Incluimos en e cédigo printf(“...”,CLK_TCK); para que, mediante la macro

CLK_TCK, se presente por pantalla e nimero de ticks por segundo. Obtenemos

100 ticks/seg.
= Tablade resultados de “bancoDePruebas3 7.cpp”:
N° | teraciones tiempo Suma (s) tiempo Producto (9)
100 * 10° 9 9
200 * 10° 19 18
500 * 10° 46 46
10° 91 91
1.5* 10 136 137
= Repetimos las medidas, pero con los cuerpos de los bucles “for” comentados:
NC | teraciones tiempo Suma (s) tiempo Producto (9)
100 * 10° 9 9
200 * 10° 18 18
500 * 10° 46 46
10° 91 91
1.5* 10° 136 137

= Comentarios: los resultados son excesivamente similares.
Modificamos €l codigo de forma que solo se soliciten las operaciones de suma y
depuramos.
I ntentamos colocar un “breakpoint” sobre la operacion “vatva’, pero no se permite.




De acuerdo con e codigo ensamblador
(for(k=0;k<noper;k++) {vatva;}) tenemos:
mov r0#0 11k=0;
cmp rO,r4 /Ik<noper;
bge  Ox80eS; //sdlto s mayor €l igua
add r0,r0,#1 IIk++;

asociado a bucle “for

= En donde no aparece ninguna instruccion asociada a “vatva'.
Al intentar definir un watch asociado a “va’ e depurador nos muestra un mensgje
gue dice: Variable removed by Compiler (optimization).
En ADS v1.2: Edit > DebugRel Settings... > ARM C++ Compiler > Debug/Opt/
= Definimos Optimization Level en Minimum (best debug wiev).
En e depurador intentamos definir un breakpoint en “vat+va’: ahorasi 1o permite.
Observamos el cddigo ensamblador asociado a “vatva’: NOP (no operation).
Definimos aux=vat+vay compilamos. Ahora no tiene asociada NOP.

= Tablade resultados;
NC | teraciones tiempo Suma (s) tiempo Producto (9)
10* 10° 7 8
20* 10° 15 15
50 * 10° 38 38
100 * 10° 76 77
200 * 10° 151 155

Tabla de resultado (con los cuerpos de “for” comentados):

N° | teraciones

tiempo Suma (s)

tiempo Producto (s)

10 * 10° 1 1
20 * 10° 2 2
50 * 10° 4 4
100 * 10° 9 9
200 * 10° 18 19

Comentarios. ahora si se observan grandes diferencias entre realizar los calculos o

s0lo la gestion de los mismos.

= Paralasuma se usa el 88.08 % del tiempo en los célculos; realizandose 1,5035

MFLOPS? para sumas.

» Parad producto, € 87.74 %; realizandose 1,4705 MFLOPS para productos.
3) Objetivo: Repetir las medidas, pero con enteros.
4) Paradlo:
a) Cambiamos €l tipo de dato de las variables a operar de flotante a entero.
b) Guardamos los cambios como “bancoDePruebasint.cpp”.

¢) Definimos € nivel de optimizacion del compilador a minimo.

d) Tablade Medidas:

NC oper aciones Tiempo Suma (9) Tiempo Producto ()
10* 10° 1 2 1 2
20* 10° 2 4 2 4
50 * 10° 4 10 5 10
100 * 10° 9 20 9 21
200 * 10° 18 40 19 42

i) Lascolumnas 22y 42 se refieren al computo sin € cuerpo de “for”.
ii) Lascolumnas 32y 52 se refieren a computo con e cuerpo de “for”.

2 MFLOPS: million of floating point instructions per second




iil) Parala suma se usa €l 55% del tiempo para los calculos; realizandose 9.090
MINTS? para sumas.
iv) Parae producto, el 54.7%; realizandose 8.704 MINTS para productos.

5) Objetivo: desarrollo defiltro de orden 1 y medida de resultados.
6) Cddigos fuente asociados. “filtro_ordenl.cpp” para flotantes y, para enteros,
“filtro_ordenlint.cpp”.
7) Tablade resultados:
Flotantes Enteros
NC oper aciones Tiempo () NC oper aciones Tiempo ()
1000 21 1000 19

a) Luego seinvierten unos 21 mg/ciclo con flotantes y 19 ms/ciclo con enteros.

b) En este computo se ha contabilizado sélo € tiempo invertido en la resolucion de
la ecuacion en diferencias. A la hora de considerar € limite temporal en los
lazos de control hay que contar todo € tiempo invertido, tanto en las
operaciones como en el control de flujo.

21.3.2003:

1) Objetivo: operaciones estadisticas:

a) Caracteristicas del proceso:
i) Enlinea

ii) Célculo de medias, varianzas 'y de estadisticos superiores:
(1) m=E[x]; chi, = E[(x-m)"];

iii) Estudio de tiempos seguin €l orden (n) y €l nimero de muestras (N).
iv) Extensién a aritmética enteray flotante.

b) Definimos e proyecto Imagen Ejecutable ARM con € nombre:
“Calcul oEstadistico.mcp”.
2) Tabla de Resultados (flotantes) de “ Cal cul oEstadistico2.cpp”:
Orden del estadistico (n)
2 3 5 10
100 4 11.001/0.329| 3 |1.000|0.245| 2 ]0.999|0.162| 2 |1.000|0.086
| 1000 | 21 |1.000/0.333] 16 |1.000/0.250| 12 |1.000|0.166] 20 |1.000|0.090
£| 2000 | 37 |1.000(0.333] 40 |1.000{0.250| 42 |1.000|/0.166| 41 |1.000|0.091
5000 | 92 [1.000|0.333| 102 |1.000|0.250| 101 |1.000|0.167| 86 |1.000|0.091
10000 | 204 |1.000|0.333| 199 |1.000|0.250| 207 |1.000|0.167| 214 |1.000|0.091
a) Siendo, tras N iteraciones:
i) 18 42 72y 107 columnas los segundos invertidos.
i) 22 52 82y 112 columnas la media estimada de las muestras.
i) 3% 6% 92y 122 columnas el estadistico de orden n estimado.
b) Siendo la media y variacion de la variable aleatoria de entrada: 1.0 y 0.01,
respectivamente.
3) Tabla de Resultados (enteros) de “ Cal cul oEstadistico3.cpp”:
Orden del estadistico (n)
2 3 5 10
100 1 | 10000 | O | 3 |10000| O 2 10.999|0.162] 1 | 10000 | O
_| 1000 | 18 | 10000 | O | 22 | 10000 | O | 20 |1.000/0.166| 20 | 10000 | O
£| 2000 | 42 | 10000 | O | 47 | 10000 | O | 35 [1.000{0.166| 45| 10000 | O
5000 |113| 10000 | O [ 103 | 10000 | O | 104 |1.000|0.167]|108| 10000 | O
10000 | 235| 10000 | O | 225 | 10000 | O 1.000|0.167 10000 | O

3 MINTS: million of integer instructions per second.




4)

5)
6)
7)

8)

9)

a) No existe mucha diferencia entre ambos casos puesto que para el célculo de chiy
se precisa € uso de lafuncion “pow” que trabaja con “double’.

b) Lamediay variacion de la variable aeatoria de entrada: 10000 y 100.

Objetivo: Adaptacion del Codigo “InvertirMatriz2.cpp” a uC.

a) Generacion de nuevaimagen gecutable para ARM: “inversionMatriz.mcp”.

b) Adaptacion de Rutinasy Librerias.

c) Generalizacion de “invertirMatriz3.cpp” para trabgjar con enteros o flotantes,
paraéello:
i) typedef float entrada; /Ipara trabajar con flotantes.
i) typedef integer entrada; //paratrabajar con enteros.
iif) Adaptacion de las funciones pertinentes.

d) Compilado correcto: eliminacion de errores. OK

Probar casos sencillos de matrices para el depurado.

Incluir cuenta del tiempo: “invertirMatriz4.cpp”.

Tabla de Resultados:
Tiempo ()
Dimension (n x n) Flotantes Enteros
4 0 No procede
5 0 No procede
6 0 No procede

Definir archivo “matrices.cpp” que contenga las funciones de gestion y de

tratamiento de matrices.

a) En “invertirMatriz5.cpp” esta el codigo necesario para presentar los datos de la
tabla anterior y las llamadas a |las funciones de gestion de matrices.

b) La generacion de entradas aeatorias de la matriz se ha redefinido para que sea
correcta: y=(max- min)*U(0,1)+min=> y = U(min,max);

Para 6rdenes mayores o iguales a 7 €l algoritno provoca una interrupcién a uC que

aborta la gjecucion del agoritmo.

10) Objetivo: Estudio de la cantidad de entradas de matriz que han de estar reservadas

en memoria a mismo tiempo parainvertir una matriz de orden n x n.

» Propiamatriz: rf entradas.

1 matriz adjunta de orden n-1: (n-1)? entradas.

1 llamada a “Det” con orden n2: 1 adjunta de orden n2: (n-2)? entradas.

Y asi sucesivamente hasta: 1 llamada a“Det” con orden 2: 2° entradas.

L uego, aunando todas; N <= SUM{k? k=2 k=n};

La placa de ATMEL ARM7eb40a dispone de 256kb para usuario de RAM;

luego: Si N = 256 * 210/ sizeof(float) = 65536 = n<60.

c) Asi pues, e orden queda limitado a 60 seguin lamemoria del sistema.

d) El limite por tiempo es tremendamente mas restrictivo, asi que no hara fata
modificar el codigo para que contemple el caso de que la reserva dindmica de
memoria fale (devuelva NULL).

g\g)/lll

11) Objetivo: a partir del “filtro_ordenl.cpp” extensién para un filtro de orden n,m:

v GEZY)=(zt+ ...+ bpz™ /(A + &zt + ... + aZ"); m<n: causalidad;
a) Generalizacion para gue se use en tanto para flotantes como para enteros.



Apunte 16:

26.3.2003:

1) Objetivo: Depurar €l cédigo de filtroNM.cpp en uC y obtener tabla de resultados.

2) Problemaética: la generacion de los coeficientes del filtro no esta correctamente
definida, se redefine correctamente mediante: y = (max - min) X + min.

3) Se reconstruye € codigo para que trate diferente nimero de iteraciones,
obteniéndose |a siguiente tabla de tiempos de computo.

N° Operaciones
Orden (n, m) 100 1000 10000

. (1,1 1 14 210
by (2,2) 2 26 -
Q. (33) 2 25 -
& (4.,4) 2 20 -
= (5,5) 2 23 -

(10,10) 4 25 -

(20,20) 2 29 -

(50,50) 3 31 227

4) Resultado: la mayor influencia en € tiempo de computo la tiene € control de flujo
mas que €l propio calculo de la respuesta del filtro, esto se manifiesta en la escasa
influencia del orden.




Apunte 17:
2.4.2003:
1) Objetivo: Probar “Matrices’ en uC para obtener la tabla de tiempos asociada (bgjo
el compilador “Angel”).
a) Archivos fuente: “InvertirMatriz5.cpp”, “matrices.cpp”.
b) Proyecto: “inversonMatriz.mcp”.
2) Editamos “matrices.cpp’:
a) ERROR: en la funcion asignavVaoresMatrices la generacion aleatoria no esta
correctamente definida.
i) Semodificapor ésta: y=(max-min)x+min = U(min,max); x = U(0,1);
ii) Comprobando la generacion aeatoria: ahora si es correcta.
3) Realizamos las medidas para flotantes: max=10.0; min = -10.0.
a) ERROR: para orden >=7x7 la rutina cuelga €l uC; para 6rdenes menores se
gjecuta correctamente invirtiendo <100ms en lainversion.
b) Depuramos para orden >=7x7, pero no se arregla: posiblemente le falte memoria
en la placa pararealizar los célculos.
4) Objetivo: Notas de conversacion con Ismael Alcala
» Sistemadel helicoptero: x'=Ax+Bu; x T A®Lul A*L AT A% BT A%
= No intervienen matrices de orden mayor que 6 =» usemos € algoritmo de
“invertirMatriz5.cpp”.
= Vector de ganancias de realimentacion del vector de estados: u=-Kx; K 1 A%®;
= Las constantes se calculan fuera de linea bgjo Matlab-Simulink-RTW. RTW
genera un esqueleto en C++ del diagrama de bloques de Simulink, el cua se
puede compilar para el uC.
= Disefio: Tiempo de muestreo de 1ms.
= Disefio de Aplicaciones:
= Rutina que simule € sistema (en PC) y su control (en uC) para estimacion de
tiempos.
= Desarrollo de aplicacion de comunicaciones via puerto serie en Visual Basic 0
Visua C++ paraplataforma PC.
» Desarollo de interffaz para la introduccion de referencias (orientacion,
velocidad) y laindicacion de los resultados de la ssimulacion para plataforma PC.
= Diagramade bloques del sistema:

1) PC uc
Simulador del modelo | pyerto Puente CAN puente | !mplementael Algoritmo de control:
dinamico del Sarie Filtro de Kalman
helicdptero LOR

5) Objetivo: Obtener una medida de tiempo més precisa de la inversion de matrices.
para ello se pretende el desarrollo de una rutina que invierta N veces la misma
matriz.

a) Archivos fuente: “invertirMatriz6.cpp” y “matrices.cpp”’.
b) ERROR: problemas de “excepcion” en uC conforme se aumenta € nimero de
iteraciones: Menor umbral en iteraciones a mayor orden de la inversion.

3.04.2003:

1) Objetivo: implementar u=+Kx; efectuar medidas de tiempo:

a) medir tiempo de iteracion.
b) Sea

1) K=Kyl 1=1234;)=12,...6

i) ul,...,u6,x1,....x6: variables; auxl,...,aux6: variables auxiliares.
c) Esquema



tO=clock();
REPETIR N
leer x; /Nleer de 6 posiciones de memoria (emulacién bus CAN).
caculau
escribir u; /lescribir en 6 posiciones de memoria (emulacion bus CAN).
FIN REPETIR
t1=clock()-t0;
d) Guardado en .../C++/Control Prop.cpp.
€) => efectuar medidasy calibrar Tm minimo (&l lunes 7.04.2003).
2) Objetivo: Desarrollo de aplicacion de comunicaciones via puerto serie en Visua
Basic.
a) Ficheros fuente: pruebal.vbp, frmPrueba;
b) Paralaversion mejorada: Prueba2.vbp.
c) Ve => Objeto: ver e formulario.
04.04.2003:
1) Objetivo: Estudio del Filtro de Kalmany del algoritmo LOQR
a) Desarrollo de su algoritmo en C++ parael uC (on-line).
b) Obtencion de medidas de tiempo.
2) Notas:
» Existen dos tareas:
= Cada N muestras (iteracion) se actualiza LQR: cambios en las codiciones
externas o internas han podido modificar A, B o C: cambia, por tanto, Knr.
» En cada muestra se actualiza €l estimador de KALMAN.
» Requiere de kernel mutitarea en tiempo real.
= Buscar librerias de tiempo real para los compiladores del uC entre la
documentacién que ha proporcionado € fabricante.
3) Objetivo: Plateamiento de Algoritmo parala gestion de tiempos:
a) Archivo fuente: “TiempoPrueba.cpp”.
b) Probar en uC el Lunes 7.04.03.
c) Intefaz multitarea con gestion de tiempos:
int retraso(clock _t, clock_t);
static clock _t t; //marca de tiempo de la tarea (se ha de definir una por tareq)
/[global: vistaen “main” y en “nombre_tarea’
//static: guarda el valor entre diferentes |lamadas a nombre_tarea
void nombre_tarea(clock _t);
int main(void) /Ikernel en tiempo real emulado
{
clock ttm; //tiempo de muestreo de latarea (uno por tareq)
tm=XXX; /ivaor numérico del tm (ms)
t=clock(); /liniciamos la marca de tiempo

for(;;)
{
nombre_tarea™; /11 linea por tarea
//cédigo de fondo (background)
ieturn 0;
}

void nombre_tarea(clock_t tm) /Ise constituye una funcion por tarea

{



if(retraso(tm,t)) return; /Il s 1, no se gecutalatarea

/lcuerpo de latarea /I s 0: se gecutalatarea
t=clock(); /lactualizamos la marca de la tarea (slo S ésta se g ecuta)
return;
}
int retraso(clock_t tm, clock_tt0)  //tO hade ser local y dinamica a “retraso”
if(tm>clock()-t0) return 1; // devuelve 1 se no se ha cumplido € tiempo tm
else return O /l devuelve O si ya se ha cumplido el tiempo tm
}
d) Comunicacion entre tareas. uso de variables globales (todas las variables son
atémicas).

4) Objetivo: Medidas del peso del kernel (main) frente al resto de taress:
a) medidas del peso del computo de cada tarea.
b) medidas del nimero de veces que se g ecuta frente al que debiera gjecutarse cada
tarea.
c) medidas de tiempo de gjecucién de fondo (background).
d) =>» Cdlibracién respecto al tiempo de muestreo de cada tarea.
5) Resultado de medidas: s tm<10ms => l|a diferencia frente a comportamiento
deseado > 15%, aunque el peso de fondo supere el 99.95 %.
a) medidas tomadas en PI1233 sobre W98.
b) repetir las medidas sobre uC de Atmel € Lunes 07.04.03.
05.04.2003:
1) Notas: Esquemade Aplicaciones - HW:

Puerto Interfaz Simulador: -
uC CAN Sarie de Datos Sistema Dinamico Navegador JavaScript VRML

Controlador plataforma PC

2) Documentacion:
a) Java www.sun.com/ downloads.html
b) VRML:
i) Especificaciones:
(1) www.web3d.org/Specifications;
(2) www.web3d.org/fs-specifications.html;
(3) www.sdk.web3d.org;
ii) Editoresy Visores:
(1) VRMLPad: ftp://ftp.parallel graphics.com/parallel graphi cs/binl/vrml pad.exe
(2) Cortona (iexplore): ftp://ftp.parallel graphics.com/parallelgraphics/bind/cortvrml.exe




Apunte 18:

9.4.2003:
1) Objetivo: Prueba de algoritmos en uC de ATMEL.:

a) Obtencién de medidas de tiempos.

b) Caodigos fuente: Control Prop.cpp (u=-Kx) y tiempoPrueba.cpp.

2) Depuramos € primer codigo para que sea Optimo: cambios guardados en

Control Prop2.cpp.

a) Opciones del compilador C++ para ARM en su grado minimo de optimizacién:
se pretende que toda instruccién en codigo fuente tenga su correspondiente
imagen en cddigo maguina.

b) Se depurainstruccién ainstruccion para observar que pasa por todas €llas.

o . . Tiempo (Is) por
NO repeticiones Tiempo (cs) ter acion
10° 300 30
5-10° 1600 32
10° 3300 33

¢) Luego, setomacomo 33 s por iteracion. Cadatick del gestor de tiempos del uC
se genera cada centésima de segundo.

d) Gracias a los tiempos de respuesta tan pequefios, se permite introducir un
estimador de estado (observador o filtro de Kalman).

3) Depuramos “tiempoPrueba.cpp”.

a) Eliminamoslos avisos (warnings) a compilar.
b) Para 2500 ticks (25 segundos) se obtiene:

N©° veces que se N©° de veces que se Tiempo por
Peso por tarea (%) g ecu?é debi6 g ecgtar chequ%op()cs)
Tarea0: | 8.027 24 2500 8.36
Tareal: | 8.027 25 833 8.36
Tarea2: | 8.361 25 500 8.36
Fondo : 75.585 8.36

¢) El modelo planteado de kernel NO es valido: buscamos las librerias para €l
compilador sobre gestion de tiempos.

d) Observando los subdirectorios de ARM hemos encontrado la libreria time.h. La
cua incluye € prototipo de la funcion “clock()”. No se ha encontrado, en €
resto de librerias funciones del tipo “wait” o “delay”.



Apunte 19:
10.04.2003:

1) Objetivo: Estudio del funcionamiento y de las facilidades del paquete “Real Time
Workshop© Embedded Coder©” de Matlab®©.
2) Esquemajeréarquico de dependencia:

Atmel AT91TDMI

M otorola M PC555

Texas Instruments

T1C6000

Real Time Workshop© Embedded Coder©

Real Time Workshop©

Simulink©

compilador Matlab© C

Matlab©

3) Diagrama de Blogues sobre e funcionamiento:

Cddigo .LIC
adaptacion @ J T

4) Planteamiento:

Matlab©
Cadigo Simulink©
RTW® Embedded Coder©

=~

Codigo C++

=~

Compilador CodeWarrior
para ATO1TDMI

Codigo maquina
para ATOLTDMI

!

b)

a) Estudio de los gemplos y facilidades de “Motorola® MPC555” y de (Texas
Instruments© TIC6000”.
i) Compilado automatico.
ii) Adaptacion de codigo .lic acddigo .cpp automatizada.
iif) Monitorizacion de Sefiales (uso de observadores — watchers).

b) Generacidon y prueba en simulink de los gemplos y estudiar € codigo .lic
generado con la intencién de obtener relaciones de adaptacion para el cédigo
.cpp adecuado a AT91TMDI de Atmel©.

i) Ejemplos tipo: multiplicacién de matriz con vector.

ii) sefia escaldn con un “scope’ (osciloscopio): monitorizacion.

13.04.2003:

5) Objetivo: se ha discriminado la documentacion del CD “Ayuda Matlab 6” relativa
al objetivo anterior pasdndose a formato papel para su mejor estudio. En concreto se

ha resaltado:

a) RTW: Arquitecturadel Programa.

i) Introduccion.

ii) Modelo de Ejecucion.




(1) Temporizado del Modelo (Model Timing).

(2) Ejecucién de Programa.
iii) Prototipado Répido dentro del Marco de Programa.

(1) Arquitectura.

(2) Componentes dependientes del Sistema.

(3) Componentes independientes del Sistema.

(4) Componentes para Aplicacion.
iv) Marco de trabajo para Programa Imbuido (Embedded Program Framework).
Codificador Imbuido 3.0 para RTW: Notas de Realizacion.
i) Introduccion.
Codificador Imbuido 2.0 para RTW: Notas de Realizacion.
Codificador Imbuido 1.0 para RTW: Notas de Realizacion.
TIC6000 DSP 2.0: Notas de Realizacion.
MPC555: Notas de Realizacion.



Apunte 20:

23.4.2003:

1) Objetivo: Elaborar un resumen — esquema de la funcionalidad de RTW® y RTW
Embedded Coder®.
a) Arquitecturade Programa para RTW:

Ediciénen o
Simulink® |::> Codigo C++
&)pci ones

- —
= SistemaMonotarea o Multitarea.
= Objetivo Imbuido o no.
= Aplicaciones Incorporadas.

i) Estilosde Cédigo:
(2) Imbuido: RTW Embedded Coder ®.
(2) Prototipado Rapido (simulacion através del codigo):
(& Tiempo real genéricoy reubicable (malloc) sin SO en tiempo real.
(b) Funciones-S. se incluye una funciénS dentro de un moddo de
Simulink® mediante un archivo C-Mex.
() VxWorks®: pruebas sobre un SO en tiempo real.
(d) Rea Time Windows/Dos ®: tiempo real por interrupcion.
b) Modelos de Ejecucion.
i) Monotareay sin tiempo real.
ii) Multitarea (uso de pid) y sin tiempo real.
iii) Monotarea y con tiempo real (temporizador parainterrupcion periodica).
iv) Multitarea (uso de pid) y tiempo real por interrupcion.
c) Entorno de Programa para Prototipado Rapido.
i) Generacion de Cadigo:
(1) Ecuaciones del Modelo del Sistema.
(2) Blogues de Parametros e Inicializacion.
ii) Cdbdigo adicional: API (estructuras para encapsulado de datos):
(1) Modelos de Aplicacion.
(2) Entorno de Programacion.
(3) Generacion de Programa Auténomo mediante RTW Builder®.
d) Arquitectura para Prototipado Rapido:
i) Interfaz en Tiempo de Ejecucion:
(1) Componentes Dependientes del Sistema:
(8 Programa Principal.
(b) Temporizacion e Interrupciones.
(c) E/S, historial de datos.
(d) Comunicacién con Médulo Externo.
(2) Componentes Independientes del Sistema:
(&) Resolvedores de la Integracion.
(b) Plan de Ejecucion del Modelo.
if) Componentes de Aplicacion:
(1) Cédigo del Modelo.
(2) Estructura de Datos del Modelo.
(3) Funciones-S.
(4) Parametros del Modelo.
€) Mainen RTW:



i) Iniciaizacion:
(1) Constructor del Modelo.
(2) Tamafio de laInformacion del Modelo.
(3) Vectores de Muestreo y Offsets, Estados y manejo de Interrupciones.
(4) Define latarea de fondo (background).
ii) Ejecucion del Modelo:
(1) En background: tareas:
(& Comunicacion con € Host.
(b) Esperahasta € préximo Instante de Muestreo.
(2) Rutinade Gestion de Interrupcion del Temporizador:
(&) Ejecutar el Modelo.
(b) Guardar datosy resultados del Modelo en buffer.
iif) Terminar el Programa: Destructor del Modelo:
(1) destruccion de la estructura de datos del modelo.
(2) desaloja de lamemoria en modelo (s dindmico).
(3) escribe resultados en un archivo para su estudio posterior.
f) Entorno de Programa Imbuido: Andlogo d caso de Prototipado Rapido, pero
optimizando en proceso en tamafio, velocidad y recursos.
g RTW Embedded Coder®.
i) Referencias: Real Time Workshop ® Embedded Coder ® User’s Guide.
ii) Esguemas de Aplicacion:
(1) Una placa con control en tiempo real sin un SO en tiempo redl.
(2) UnaWS con WxWorks® para depurar €l codigo.
iii) Capacidades:
(1) programa principal autogenerado: ert_main.c.
(2) Generacion de Plan de Trabajo (Scheduler) deterministac multitarea y
multi - tiempo de muestro.
(3) Interrupciéon Asincrona.
(4) Validacion del Codigo desde Simulink® (depurador).
(5) Modificacién manual del cédigo C.
(6) Generacion de resumen y documentacion como de las trazas en HTML.
iv) Restricciones:
(1) No permite estados continuos:. slo discretos.
(2) Evitar los bloques que dependan del tiempo absoluto cuando se disefie
algoritmos de tiempo infinito.
(3) Toda funciénS debe tener su fichero .tlc.
(4) Blogues no soportados™:
(& Continuos.
(b) Mantenedor de orden 1 (FOH).
(c) Funcionesy Tablas de Matlab®:
(i) Matlab Fen.
(it) M-file, Fortran S-functions, C-Mex S-functions.
(d) Constantes algebraicas.
(e) Fuertes: clock, chirp signal, ramp, repeating sequence, signal
generator.
h) Objetivo Imbuido para Motorola® MPC555.
i) Produccion de Codigo desde Simulink®:
(1) Para compiladores cruzados:. genera archivos de proyecto y codigos
objeto (soporta Metrowerks CodeWarrior).

* pagina5-2: RTW Embedded Coder User’s Guide: ecoder_ug.pdf.



(2) Soporta depurador: Metrowerks CodeWarrior Debugger.
i) CAN Calibration Protocol Block: compatible con Visual C/C++ Compiler.

24.4.2003:
2) Objetivo: Estudio de Funcionamiento de Matlab® y RTW®:

3)

4)

a)

b)

Ejemplo Prueba: “untitled”. Diagrama Simulink®:

gzt
Gz )_1+O.22'1 @

u(n) Outl

Al compilar para RTW® se genera una serie de archivos en la carpeta del

espacio de trabagjo de Matlab®: d:\matlab6p5\work\untitled grt_rtw.

i) Siendo:

(1) grt: generic real time.
(2) rtw: real time workshop.
if) Archivos.cy .h:
() untitled data.c.
(2) untitled.c: proporciona €l interfaz en tiempo de gecucion.
(3) untitled types.h.
(4) untitled_private.h.
(5) rtmodel.h: contiene el modelo de Simulink ®.
(6) untitled.h.

Dentro de la carpeta D:\matlab6p5\work se generaron los archivos:

i) untitled.exe: a eecutarlo genera “untitled.mat” con los resultados de la
simulaciéon en e formato .mat adecuado para Matlab®. Al no definir un
objetivo en @ compilador RTW® se tomd por defecto: pcwin.

i) untitled.mdl: describe e modelo del sistemabajo Simulink ®.

Objetivo: Probamos € compilado de los ficheros generados por RTW® en
Metrowerks CodeWarrior ®.

a)

b)
<)

d)

Generamos un nuevo proyecto en CodeWarrior ®:
i) Rutade Directorio: ...serlat\Mis Documentos\Cédigos Fuente\RTW\untitled.
i) Archivo: untitled.mcp.
Afiadimos todos los archivos .c y .h que generd Matlab® al proyecto nuevo.
Preprocesamos uno a uno:
i) Seproducen errores en los archivos .c a no poderse encontrar 3 librerias por
no saber su ruta de directorio. Se buscaron con Windows ®, siendo:
(1) d:\matlab6p5\include\bin\tmwtypes.h
(2) d:\matlab6p5\simulink\c\simstruct_types.h
(3) d:\matlab6p5S\rtw\include\c\rt_logging.h.
ii) Afadimos estas tres librerias a proyecto.
Compilamos todos los archivos del proyecto: sin errores; aparece un aviso.
i) El fichero “untitled.c” posee 1244 lineas de codigo y 568, de datos.

Objetivo: estudio de untitled.mat en Matlab ®.

a)
b)

c)

Se carga en € espacio de trabgjo e fichero untitled.mat.

Se renombran las variables por comodidad:

i) t=rt_tout; % rt_tout = real time _t out

i) y=rt_yout; % rt_yout = real time _y out

mediante plot(t,y) aparece la gréfica tipica de la respuesta a escaldon de un
sistema de primer orden en discreto, tal y como habia predicho Simulink ®.



Apunte 21.
25.4.2003:
1) Objetivo: descargar €l cddigo alaplacay depurarlo con CodeWarrior.

a) Problema: tras la descarga e iniciacion de la gjecucién, € depurador muestra en
mensaje; “Processor ARM_1 raised an exception. Cause: the processor was
reset”.

b) Solucién planteada: indicar d RTW® que se trata de un sistema imbuido
(embedded) para que no tome por defecto la configuracion PCWIN.

= Abriendo Matlab - Simulink - Open - untitled.mdl y dentro de la ventana del
modelo: Tools > RTW - Options > Browse (System Target File) se cambia:

= grt.tlc (generic Real Time) por ert.tlc (RTW Embedded Coder).

» Rutadeert.tic: ...Matlab6p5S\rtwAc\ert\ert.tlc.

= En“Category” escogemos:

= ERT code generation options (1,2 y 3): se definen las opciones.

= Se toma ANSI_C como esténdar para flotante en lugar de 1SO_C (por
compatibilidad con el micro de ATMEL).

= Sesolicitalageneracion del reportaje en HTML.

= Objetivo (target) : “bareboard” (placa simple).

c) Paraéd diagrama de bloques untitled.mdl se genera el codigo C++ obteniéndose,
segun € reportge HTML, para la ruta ...matlab6p5\work\untitled ert_rtw los
ficheros:

= ert_main.c; untitled.c; untitled data.c;

= untitled.h; untitled private.h; untitled_types.h;

d) Estableciéndose la dependencia estética con las siguientes librerias de Matlab®:

= .. matlab6p5\externincludetmwtypes.h;

= ...matlab6p5\simulink\include\simstruc_types.h;

= ...matlab6p5\rtw\c\libsrc\rt_logging.h;

€) Definimos un nuevo proyecto en CodeWarrior: ..\rtw\ertPruebal; en é
incluimos todos los archivos generados por RTW® Embedded Coder® vy las
librerias con las que existe dependencia estética.

f) Make: mensgje con tres errores porque no existe la definicién de los simbolos:

* rt_UpdateTXYLogVars.

= rt_StartDatal ogging.

= rt_StopDatal ogging.

g Solucién: un sistema imbuido por € de ARM no posee dispositivos de
almacenamiento en los que guardar |os resultados del buffer tras la simulacion.

i) Nota: RTW® generd un gecutable (...\work\entitled.exe) asociado a la
compilacién y construccion con RTW® Embedded Coder ® (por defecto usa
el compilador para PcWin).

ii) Lo gecutamosy genera “untitled.mat” como resultado.

h) Guardamos el modelo como ...\work\ertPruebal.mdl.

i) Construimos € codigo C++ con RTW® que se guarda
en...\work\ertPruebal ert rtw.

i) En las opciones de RTW® se inhabilita la generacion de un historial con €
formato de un archivo para Matlab® (Mat — File Logging).

i) Al gecutar e gecutable (..\work\ertPruebal ert rtw\ertPruebal.exe) se
indica por la salida estdndar que se programa simula en tiempo infinito.

j) Guardamos & modelo Simulink® como “ertPrueba2.mdl” inhabilitada la opcién
del fichero de historial para compilar con CodeWarrior.



k) En un nuevo proyecto para CodeWarrior (ertPrueba2.mcp) se afaden los
ficheros .c y .h asi como las dependencias estéticas, se compila sin errores y se
depura.

) En AXD Debugger se descarga (modo USER) y se gjecuta: aparece € mismo
mensgj e de gecucion indefinida, aunque no se resetea e micro como antes.

m) En Matlab®: pretendemos usar “Externa Interface Control Panel” para
comunicarnos con la placa desde Matlab®, pero la placa no responde o no
soporta este funcionamiento (quizas e archivo de interfaz C-Mex no esté
definido) =» trabgjaremos con CodeWarrior como interfaz con la placa (por
ahora).

2) Objetivo: depuramos & codigo de “ertPrueba2” con AXD Debugger para incluir e
codigo “printf(“Vaor de sdlida: ....);".
a) Error: en la funcion “rtmGetErrorStatus(ertPrueba2.M)” no se puede entrar ni
siquiera usado “ Step in”.
b) Solucion: probamos con “ertPruebal”’, pero ni siquiera compila porque esta
activada la opcion que genera @ historial para Matlab® -simbolos indefinidos-:

i) Buscamos esos simbolos en e contenido de todos los ficheros que cuelgan
de ...matlab6p5\..., pero no se encuentran en ninguno.

ii) Buscamos en la ayuda de Matlab®:

(1) “rt_UpdateTXYLogVars’ contenido en “Signal Monitoring via Block
Outputs’.
(2) “rt_StartDatal_ogging” y “rt_StopDatal_ogging” no se encuentran.

iii) Se trata de variables que estén definidos dentro de la estructura del modelo,
pero que lo se usan cuando se genera un fichero de historial. No queda
mas remedio que usar “watchers’ dentro del depurador AXD e inhabilitar la
opcién de generacion del fichero de historial.

c) Problema: no se puede encontrar fécilmente cudles son los nombres de las
variables que da Matlab® en el desarrollo del codigo C++.
3) Modelode Trabajo: RTW® Embedded Coder ®:
a) con .mat logging: cuando la simulacién del diagrama Simulink ® genere
gjecutable en PC.
b) sin.mat logging: cuando la aplicacién resida en la placade ATMEL.
i) Modificacion del codigo para observar la simulacion:
(1) Comunicacién con la Consola.
(2) Comunicacion viabus CAN.
28.4.2003:
1) Objetivo: desarrollo del bucle de ganancias de realimentacion con Simulink ®:
a) Diagramade Bloques: ...\work\gainMatrix.mdl.
X(Mea [ ] UM
2) Objetivo: observar y analizar los archivos .tlc para definir la configuracion del
target para ARM7TDMI de ATMEL con € compilador Metrowerks CodeWarrior.
a) Especificar como compilador CodeWarrior.
3) Objetivo: Depurar ggemplo sencillo de Simulink® bajo CodeWarrior para observar
con “watchers’ el avance correcto de la smulacion.
4) Nota: Objetivos 2) y 3) definidos tras charlar con Ismael (Tutor).

Archivos .tlc: ...matlab6p5\tool boXirtw\targets\mpc555dk\mpc555dk:
= mpc555_settings.tic: Define la configuracion para el objetivo MPC555.



= Muchos de los campos que dicen donde se sitia el compilador no estan
definidos (definidos como: “”; cadena vacia de caractéres) —> permite su
definicion como ruta de directorio.

= Campos de mangjo del puerto Comm para la comunicacion con la placa
desde el depurador que aporta Simulink®.

=  mcp555rt.tic:

Incluye las librerias “mpc555_settings.tic” y “mpcb55rt_genfiles.tic”

Define TargetCompiler = “diab”; es un compilador cruzado del mercado.

Define las opciones del compilador entre las sentencias “Begin RTW_Options”
y “End_RTW_Options’.

= Estas opciones aparecen en el panel de opciones para RTW® de Simulink®.
= Algunas estan definidas, otras no.

=  mpc555pil.tlc:

a)

Incluye: “mpch55_settings.tic” y “ert_pil_lib.tlc”, paraimportar la configuracion
global, “mpch55pil_genfilestic, para construir objetivos mpcs55pil (processor-
inthe-loop).

Nota: los archivos .tlc de mpch55dk estan todos en disguette.

30.4.2003:

1) Objetivo: Definir CodeWarrior® como compilador para ARM7TDMI dentro de los
archivos que usa Matlab®. Existen archivos o carpetas que usan “diab”> debemos
estudiarlas paratrabagjar con CodeWarrior®.

a)

b)

<)
d)

Copiamos la estructura de directorio de .. .\targetsmpc555dk a
\targets\ARM 7TDMIdk para modificar todas |as cadenas de texto “ mpc555dk”
como “ARM7TDMI” tanto en los nombres de los archivos como en su
contenido.

Toda entrada “diab” se cambia por “CodeWarrior” tanto en los nombres de los
archivos como en su contenido.

Ruta del compilador: “D\SW_FCS\ARM\ADSv1 2\Bin\IDE.exe”.

Ruta del depurador: “ DASW_FCS\ARM\ADSv1 2\Bin\axd.exe”.

Nota: todala carpeta ARM7TDMIdk se ha comprimido .rar y pasado al PC233.



Apunte 22:
07.05.2003:
Objetivo: Analizar la documentacion de RTW para definir un target® propio.
Informacion de Plantillasy Targets para RTW ® Embedded Coder ®.
= ert.tlc: archivo del sistema objetivo para RTW-EC®.
= Plantillas existentes para diferentes entornos de desarrollo:
= ert_bc.tmf: compilador Borland C.
= ert_|cc.tmf: compilador LCC (propio del Matlab ®).
» et _vec.tmf: compilador Visual C.
» Rutasdedirectorio: ...\matlab6p5\rtw\c\ert
Estas plantillas contienen las macros para que las interprete e proceso make rtw, es
decir, €l proceso que elabora los archivos objeto. Siendo |as macros més representativas:
= MAKECMD: invocala utilidad “make’.
= HOST: indicala plataforma en la que reside “make’.
= BUILD: invocad proceso de construccion bajo RTW (yes/no).
= SYS TARGET_FILE: nombre del archivo del sistema objetivo (ert.tlc).
Las preferencias del target son configurables mediante el comando “settargetprefs’ que
proporciona Matlab ®. Se puede especificar los siguientes campos:
= TargetCompiler: nombre del compilador cruzado.
= TargetCompilerPath: ruta de directorio de la carpeta que contiene el compilador.
= TargetDebuggerExe: ruta de directorio del depurador.
» TargetDebugger: modo de depuracion.
=  CommHostPort: puerto de comunicaciones del equipo anfitrion.
=  CommTargetPort: puerto de comunicaciones del equipo objetivo.
= CommBaudRate: velocidad binaria de la comunicacion serie entre los dos equipos.
Definimos las preferencias para e sistema “mpc555dk” que si soporta Matlab® de la
forma:
= TargetCompiler = ‘CodeWarrior’;
=  TargetCompilerPath = ‘d:\sw_fcs\arm\adsvl 2\bin';
= CommTimeout =‘4;
= TargetDebugger = *SingleStep’;
= TargetDebuggerExe = ‘d:\sw_fcs\arm\adsvl 2\bin\axd.exe’;
= CommHostPort =‘COM2';
=  CommTargetPort = ‘COM1’;
= CommBaudRate = *38400’;
=> iiSe comprueba que no surge efecto sobre los ficheros del target MPC555DK !
8.05.2003:
Objetivo: probar codigo C generado para mpcb55 de un diagrama simple en
Simulink®.
= mpc555dk queda configurado para Metrowerks® CodeWarrior® y  AXD
Debugger®.
» Paca conectada en modo USER.
= Generacion del codigo:
= nombre del fichero Simulink®: ganancialUnidad.mdl.
= segenerael subdirectorio: ...\work\ganancialnidad.
= Habilitamos las opciones “build” y escogemos mpcS55PIL  (Processor- in-the-L oop)
como plantilla..tlc.
= PIL produce error.

® sistema HW objetivo en donde se ejecutara el codigo fuente
® Real Time Workshop ® Embedded Coder ®



=  Probemos con mpc555(algorithm — exports) como plantilla.tlc.

Generacion del Cédigo.

Se inicia CodeWarrior, pero con el compilador apropiado para mpc555 que es
“555Phytec Debug Version”, e aa no nos sirve para el microprocesador de
ATMEL.

= No funciona: no podemos engafar a Matlab®.

=  SOLUCION: generacion de la plantilla .tlc adecuada parala maguinade ATMEL.
Busgueda en la ayuda de M atlab®:

1) Tutorial: creating a Custom Target Configuration.

a)
b)

<)
d)

f)

o)
h)
i)
)

K)

Crear un directorio en € que se guarden los archivos fuente C, .tic (definicidn
del objetivo) y .tmf (plantilla). Sea:d:\matlab6p5\work\arm7tdmi.
Afadirlo como ruta de directorio de Matlab®: en la consola de comandos de
Matlab® se teclea addpath(‘ d:\matlab6p5\work\arm7tdmi’) .
Que este directorio sea el de trabgjo de Matlab® puesto que éste se usa como €l
directorio destino del codigo C que genera RTW.
Copiar €l gjemplo ‘timestwo.c’ desde:

d:\matl ab6p5\tool boxX\ rtwArtwdemos\tl ctutorial\timestwo\
En:

d:\matlab6p5\work\arm7tdmi\
mex timestwo.c Construir € archivo .mex de timestwo.c en e directorio destino,
paraello se usael comando: mex timestwo.c.
Crear un modelo de Simulink®

[\/ i -

Sfunction Scope

Sine Wave

i) Definir unafuncion S.

ii) Definir las opciones de Solver para RTW: fixed type y ode(Runge Kutta).

iif) Nombre del modelo: ...\arm7tdmi\timestwo.mdl.

Definimos e nombre ddl blogue de la funcion S como “timestwo” de forma que
quede ligado a cddigo “timestwo.c”.

Iniciar lasimulacion bajo Simulink®:

i) ERROR: & modelo y lafuncion S poseen € mismo nombre.

i) SOLUCION: nuevo nombre del modelo: senoPor2.mdl.

Simulamos: se comprueba que la salida es 2 veces la entrada.

Se necesita € archivo .tlc correspondiente a .c para generar cddigo interno
(inlined); s no, se genera una llamada a una funcién S externa. Luego se copia
timestwo.tic en d\matlab6pS\work\arm7tdmi desde la ruta de directorio
d:\matlab6pd\tool box\rtwArtwdemaos\tl ctutorial\timestwo\.

Se copia d\matlab6pS\rtwAc\gri\grt_ main.c y d:\matlab6pS\rtw\c\gri\grt.tic a
d:\matlab6pS\work\arm7tdmi  redenomindndolos  arm7tdmi_grt_main.c y
arm7tdmi_ert_main.c.

Los comentarios de arm7tdmi_erc.tlc y arm7tdmi_grt.tlc sirven para ahadir
“arm7tdmi” a mostrados de los archivos de los objetivos (System Target File
Browser).

El codigo generado por RTW se guarda en un subdirectorio cuyo nombre esta
formado por el del modelo junto con un sufijo. Para especificar un sufijo propio
de nuevo target se usa “ rtwgensettings.BuildDirSuffix = *arm7tdmi_rtw’” dentro
del archivo .tlc correspondiente.



n)

P)

D:\matlab6p5\rtwAc\grt contiene plantillas (.tmf) especificas para diferentes
compiladores tanto para un objetivo en tiempo real genérico como para €l caso
de un sistema embeddido.

i) Copiamosal ...\matlab6p5\work\arm7tdmi los .tmf: grt_Icc.tmf y ert_|cc.tmf;
asociados a compilador LCC de Matlab®.

i) Losrenombramos como arm7tdmi_grt.tmf y arm7tdmi_ert.tmf.

iii) NOTA: los cambios siguientes son solo aplicables a compilador LCC. Si se
usa otro compilador, las reglas para la fuente (REQ_SRCS) y los archivos
objeto (%.0bj :) pueden diferir ligeramente.

Cambios en arm7tdmi_grt.tmf:

i) SYS TARGET_FILE =arm7tdmi_grt.tlc.

i) REQ_SRCS=$(MODEL).C $(MODULES) arm7tmdi_grt_main.c ...

i) %.obj : $(MATLAB_ROOT)/rtw/c/grt/%.c por
%.0bj : §(MATLAB_ROQT)/work/arm7tdmi/%.c

Cambios en arm7tdmi_ert.tmf:

i) SYS TARGET_FILE = arm7tdmi_ert.tlc.

i) REQ_SRCS=$(MODEL).C $(MODULES) arm7tmdi_ert_main.c ...

iii) %.0bj : $(MATLAB_ROQOT)/rtw/clert/%.c por

iv) %.0bj : 3MATLAB_ROQOT)/work/arm7tdmi/%.c



Apunte 23:

g) Abrir el cuadro de didogo “Pardmetros de Simulacion” de RTW.

i) Enlaopcion “Browse...” aparecen 4 nuevas OpCiones:

(1) arm7tdmi_ert.tlc: RTW Embedded Coder.

(2) am7tdmi_ert.tlc: Visua C/C++ Project Makefile only for the RTW
Embedded Coder.

(3) arm7tdmi_grt.tlc: Generic Real- Time Target.

(4) am7tdmi_grt.tlc: Visual C/C++ Project Makefile only for the “grt”
target.

ii) Definiciones:

(1) System Target File: arm7tdmi_grt.tlc o arm7tdmi_ert.tlc.
(2) Template Makefile: arm7tdmi_grt.tmf o arm7tdmi_ert.tmf.
(3) Make Command: make_rtw.

r) Construccion: iniciamos el proceso “Build”.

i) ERROR: se genera e cbédigo C colocdndoe en la carpeta
.\arm7tdmi\senoPor2_grt_rtw; por lo tanto e campo BuildDirSuffix de
rtwgensettings no se ha aplicado correctamente.

i) SOLUCION: especificamos este campo en & propio archivo .tlc, no desde la
consola de comandos de Matl ab®:

(1) rtwgensettings.BuildDirSuffix = ‘_arm7tdmi_grt rtw’ en el archivo
arm7tdmi\arm7tdmi_grt.tlc.
(2) rtwgensettings.BuildDirSuffix
arm7tdmilarm7tdmi_ert.tlc.

i) Iniciamos €l proceso “Build”’: se genera € codigo C en la carpeta definida
.\arm7tdmi\senoPor2_arm7tdmi_grt rtw a seleccionar e en cuadro de
didogo ‘Pardmetros de Simulacion’ e caso de un sistema genérico de
tiempo real. Para e caso embeddido se actla analogamente, pero surge un
error puesto que RTW Embedded Coder no soporta bloques continuos con
son los del g emplo “timestwo”.

s) Editamos @ archivo: ..\arm7tdmi\senoPor2_arm7tdmi_grt_rtwAsenoPor2.c para
localizar la funcion “MdlOutputs’; en ella se observa € codigo afiadido por la
funcion S:

[* S-function block: <Root>/S-funcition*/
[* Multiply input by two */
rtB.S_function = rtB.Sine_Wave* 2.0;

‘am7tdmi_ert rtw’ en e archivo

Es decir: a blogue ‘Sine Wave' ve multiplicada su salida por 2.0 y se asigna como
salidadel bloque ‘S function’.
9.05.2003:
2) Adding a Custom Target to the System File Target Browser.
a) Modificar o afadir comentarios del examinador (Browser) en la cabecera del
archivo del sistema objetivo:
i) Enarm7tdmi_ert.tlc:
(1) %SYSTLC: RTW Embedded Coder for ATMEL ARM7TDMI.
i) Enarm7tdmi_grt.tic:
(1) %SY STLC: Generic Real-Time Target for ATMEL ARM7TDMI.
b) Generar un subdirectorio que contenga:
i) archivo del sistema objetivo.
if) archivo ‘make’ de plantilla (.tmf).



iif) archivos del interfaz en tiempo de gecucion (programa principal y las
funciones S).
Nota: debe estar este subdirectorio dentro del directorio raiz de Matlab®.
c) Afadir el camino: addpath <nombreDel Directorio>.
=>» para que € camino se afiada cada vez que Matlab® arranque se ha de incluir esta
linea de comando en €l fichero ‘startup.m’.
3) Objetivo: Extender la configuracion del compilador cruzado por defecto de
Mpc555dk al compilador Metrowerks CodeWarrior® paraarm7tdmi®.
a) Los archivos .tmf contienen lainformacién del compilador concreto.
b) Estudiemos como se configura“Diab C Cross-Compiler” para M pc555dk.
¢) Extendamoso alos ficheros arm7tdmi_ert.tmf y arm7tdmi_grt.tmf.
= Archivosoriginales.
1) d:\matlab6p5\toolbox\rtwitar gets\mpcs555dk \mpc555dk \mpce555_ext.tmf.
Se usa para el modo “algorithm export”: plantilla disefiada para construir una aplicacion
autonoma sobre PC mediante € generador de codigo C y e compilador “Diab Data
Power PC 4.3g".
2) d:\matlab6p5\toolbox\rtwAtar gets\mpc555dk \mpc555dk \mpc555pil.tmf.
Plantilla para construir codigo embeddido con Diab C PC.
3) d:\matlab6p5\toolbox\rtw\tar gets\mpc555dk \mpc555dk \mpc555rt.tmf.
Plantilla para construir una aplicacion auténoma para PC mediante Diab C PC.
=>» Estudiaremos €l caso B para compararlo con € fichero arm7tdmi_ert.tmf.
*» Macrosdeinterés:
= HOST: indicala configuracién del sistema anfitrion. HOST = PC.
= SYS TARGET_FILE: indicael nombre del archivo .tlc.
Para mpch55pil.tmf esta macro se define como mpch55.tic; asi pues nosotros
definimos, en el archivo arm7tdmi_ert.tmf, esta macro como arm7tdmi_ert.tlc.
» Estudiamos los archivos arm7tdmi_ert.tmf y arm7tdmi_grt.tmf:
= En € apartado “tools specifications” seindica el compilador y su uso.
= Copiade seguridad de arm7tdmi_ert.tmf en arm7tdmi_ert.bak.
» Modificamos sobre arm7tdmi_ert.tmf la configuracion del compilador para que, en
lugar de usar LCC, se use CodeWarrior®.
= PROBLEMA: no ofrece una solucion factible por incomprension de la
nomenclatura
= Observando mpc555rt.tlc:
%% import global settings
% include “mpc555_settings.tic”
%%must be diab for RT Target at thistime
% assign CompiledM odel. Settings. TargetCompiler = “diab”
=  En mpch55_settingsitlic:
= Sedefine la estructura CompiledModel:
= CompiledModel:
= Settings:
=  TargetCompiler.
TargetCompilerVersion.
TargetCompilerPath.
COM_BAUD.
CommTimeout.
COM_PORT.
CommTargetPort.



= Pathinfo:
= MODEL_FILE.
= MODEL_REL_PATH.
= Pluglns:
= MPC 555DK_PLUGIN_INCLUDES.
= MPC PLUGIN_LIBS.
= Asignacion de valores a cada uno de los campos mediante “% assign “.
= De laestructura Pathinfo
= De laestructura Settings a partir de los campos predefinidos de mpc555_group.
= Delaestructura Plugins a partir de los campos de la estructura mpc555_group.
= Guardamos una copia de arm7tdmi_ert.tlc como arm7tdmi.bak y construimos una
estructura andloga a la de mpc555rt.tic y mpe555_settings.tic.
» Modificaciones:
% assign TargetOS = “BareBoardExample’

%%import global settings:

% include “arm7tdmi_settings.tlc”

%% must be CodeWarrior for ARM Target at thistime

% assign CompiledM odel.Settings. TargetCompiler = “CodeWarrior”.

= Copiamos mpc555_settings.tic en ..\arm7tdmi_settings.tic.

= Definimos los campos de |as estructuras para CodeWarrior — Angel:

% assign CompiledM odel . Settings. CWDEFINE_PROC’ = “7tdmi”

% assign CompiledM odel.Settings. TargetCompiler = “CodeWarrior”

% assign CompiledModel . Settings. TargetCompilerPath = “d:\sw_fcs\armm\adsvl 2\bin\ide.exe”
% assign CompiledModel.Settings.BSP_Target = “DebugRel”

- Edtaba definido como “phyCore-555", que es e compilador cruzado apropiado para
mpc555 que implementa CodeWarrior. “DebugRel” es €l correspondiente a arm7tdmi.

% assign CompiledModel. Settings. COM_BAUD = 38400

% assign CompiledM odel. Settings.CommTimeout = 4

% assign CompiledModel.Settings. COM_PORT = COM2

% assign CompiledM odel. Settings.CommTargetPort = “COM2”

Modificamos el didogo de aviso (warndlg) para que sea coherente con arm7tdmi.

En los campos BSP_DIR y BSP_TLC_DIR de Pathinfo se indica la ruta de directorio
de los compiladores adecuados para ARM CodeWarrior y Tlc Matlab®,
respectivamente.

- No s como se inicializan por e complejo mapa de objetos y € desconocimiento de
la notacion de la sintaxis: las dgjamos como s fueran comentarios.

Guardamos €l archivo como .old.

= Al compilar con RTW: error en lalinea 72: el comando “%” no existe.

Linea 72: % the prefsGroup...

Linea 73: % assign ARM7TDMI_GROUP = FEVAL (“gettargetprefs’,” mpc555dk”,” structure™)
=>» Modificamos lalinea 72 como sigue: %% the prefsGroup...

= Usamos “mpc555dk” para que ARM7TDMI_GROUP se iniciadlice con la
configuracion de mpc555dk, la cua se modifico para CodeWarrior.

= Al compilar con RTW: error en lalinea 120: PIL_TLC_DIR no definido.

’ codewarrior define processor



= ExisteunareferenciaaPIL_TLC_DIR antes de que sea usada, siendo ésta:
% assign CompiledModel .Pathinfo.PIL_TLC DIR =“%<TARGET_ROOT>%<PATH_SEP>pil”
= Existe unareferencia anterior a TARGET _ROOT:
% assign CompiledM odel.Pathinfo.TARGET_ROOT = FEVAL (“filepart”,”%<TLC_DIR>",” path”)
Con la evaluacion de la funcion “filepart” se consigue obtener € camino (“path”) del
archivo especificado con “%<TLC_DIR>".
= Existe unareferencia anterior aPATH_SEP:
% assign CompiledM odel.Pathinfo.TLC_DIR = FEVAL(“filepart”,”%<TLC_FILE>",” path”)
= Existe unareferenciaanterior aTLC FILE:
% assign CompiledModel.Pathinfo.TLC_FILE = FEVAL (“strtokn”,”%<TLCFILES>","[,]",2)
=>» Pero TLCFILES no se define en arm7tdmi_settings.tlc. Veamos en la ayuda de Matlab®:
Se encuentra la entrada “TLC Error Messages’ contenida en “TLC Error Handling”. En ella se
define como se usalafuncion FEVAL, entre otras cuestiones, pero no ofrece una solucion.
=>» Posible Solucion: definir TLCFILES como es archivo .tlc.
% assign CompiledModel.Pathinfo. TLCFILES = “arm7tdmi_ert”
= Error de Compilado en lalinea 122 porque PIL_TLC DIR no ega definido.
% assign CompiledModel .Pathinfo.PIL_TLC DIR =*“%<TARGET_ROOT>%<PATH_SEP>pil”
Posible causa del error: no existe subdirectorio ..\arm7tdmi\pil.
=  Solucion: copiar € subdirectorio ..\mpc555dk\pil en ..\arm7tdmi manteniendo el
archivo arm7tdmi_settingsitlc.
= Errorenlalineal22: PATH_SEPy PIL_TLC DIR no estan definidos.
=  Solucion: e modo PIL no se implementaraen ARM7TDMI.



